using your Treo™
Includes setup information and instructions for most tasks
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Contents</td>
</tr>
<tr>
<td>5</td>
<td>Welcome</td>
</tr>
<tr>
<td>6</td>
<td>If you read nothing else...</td>
</tr>
<tr>
<td>7</td>
<td>read this now: getting started</td>
</tr>
<tr>
<td>8</td>
<td>What you'll need</td>
</tr>
<tr>
<td>9</td>
<td>Treo overview</td>
</tr>
<tr>
<td>12</td>
<td>Charging the battery</td>
</tr>
<tr>
<td>13</td>
<td>Inserting the SIM card</td>
</tr>
<tr>
<td>14</td>
<td>Turning Treo on and off</td>
</tr>
<tr>
<td>15</td>
<td>Making your first call</td>
</tr>
<tr>
<td>17</td>
<td>first day: learning the basics</td>
</tr>
<tr>
<td>18</td>
<td>Moving around the Treo screen</td>
</tr>
<tr>
<td>22</td>
<td>Using the keyboard</td>
</tr>
<tr>
<td>25</td>
<td>Launching applications</td>
</tr>
<tr>
<td>27</td>
<td>Setting up your computer</td>
</tr>
<tr>
<td>30</td>
<td>Synchronizing contacts and other personal data</td>
</tr>
<tr>
<td>31</td>
<td>Battery life</td>
</tr>
<tr>
<td>32</td>
<td>Where to learn more</td>
</tr>
<tr>
<td>33</td>
<td>first week: using phone, web, and messaging</td>
</tr>
<tr>
<td>34</td>
<td>Phone overview</td>
</tr>
<tr>
<td>36</td>
<td>Dialing calls</td>
</tr>
<tr>
<td>39</td>
<td>Receiving calls</td>
</tr>
<tr>
<td>40</td>
<td>Using voicemail</td>
</tr>
<tr>
<td>42</td>
<td>Managing active calls</td>
</tr>
<tr>
<td>43</td>
<td>More ways to manage calls</td>
</tr>
<tr>
<td>47</td>
<td>Managing contacts</td>
</tr>
<tr>
<td>49</td>
<td>Defining Favorites buttons</td>
</tr>
<tr>
<td>52</td>
<td>Using a phone headset</td>
</tr>
<tr>
<td>53</td>
<td>Browsing the web</td>
</tr>
<tr>
<td>60</td>
<td>Taking pictures with the camera</td>
</tr>
<tr>
<td>64</td>
<td>SMS</td>
</tr>
<tr>
<td>69</td>
<td>MMS</td>
</tr>
<tr>
<td>73</td>
<td>Sending and receiving messages with Mail</td>
</tr>
<tr>
<td>81</td>
<td>first two weeks: using organizer features</td>
</tr>
<tr>
<td>82</td>
<td>Calendar</td>
</tr>
<tr>
<td>87</td>
<td>To Do List</td>
</tr>
<tr>
<td>90</td>
<td>Memo Pad</td>
</tr>
<tr>
<td>91</td>
<td>CityTime</td>
</tr>
<tr>
<td>93</td>
<td>Calculator</td>
</tr>
<tr>
<td>95</td>
<td>Looking up contacts and other information</td>
</tr>
<tr>
<td>97</td>
<td>Beaming information</td>
</tr>
<tr>
<td>99</td>
<td>first month: managing applications</td>
</tr>
<tr>
<td>100</td>
<td>Installing applications</td>
</tr>
<tr>
<td>103</td>
<td>Removing applications</td>
</tr>
<tr>
<td>104</td>
<td>Using Application Info</td>
</tr>
<tr>
<td>105</td>
<td>Using expansion cards</td>
</tr>
</tbody>
</table>
Welcome

Congratulations on the purchase of your Treo™ phone. You now have

- an advanced mobile phone*
- a Palm Powered™ organizer with portable expansion capability (SD media)
- a digital camera
- email*
- web browsing*
- SMS*
- MMS**

all in one compact and indispensable device.

* Requires service contract with your mobile service provider
**MMS requires MMS services running on GPRS

This guide will help you set up your Treo and quickly learn to use it.
If you read nothing else...

This guide is designed to get you using your Treo quickly, starting with just the basics. As you become more comfortable with your Treo and want to learn more, come back and read the other sections.

Read this Now: Getting Started
Follow the instructions on pages 7-16 to set up your Treo and make your first call.

First Day: Learning the Basics
Read through pages 17-32 to learn how to enter text, move around the screen and set up synchronization.

First Week: Using Phone, Web and Messaging
Learn how to use all the great wireless features of your Treo on pages 33-80, including phone, email, web browsing, and messaging.

First Two Weeks: Using Organizer Features
Your Treo is not just a phone. It also includes a full-featured Palm Powered organizer that gives you instant access to your Calendar, To Do List, Memo Pad, CityTime, Calculator, and more. See pages 81-98.

First Month: Managing Applications
Explore pages 99-108 to learn how to add or delete extra applications and use an expansion card with your Treo.

When You're Ready: Customizing your Treo
Once you've learned the basics, you'll want to explore additional features on your Treo and customize its settings. See pages 109-126 for information about these features.

If Something Happens: Help
If something goes wrong or you can't figure out how to use a Treo feature, we can help. See pages 127-148 for the answers to frequently asked questions.
What you’ll need

As you work through the instructions in this guide, you’ll need all the items that came in the Treo box (see page 9) as well as the following:

- a SIM card for which you have an activated mobile account with data services*
- a location with wireless coverage for your phone
- an electrical outlet
- the computer with which you will synchronize your personal data
- the CD included in the box

* We recommend choosing the GPRS data service option. You cannot use email, web browsing, or picture messaging without data services of some type.

Treo overview

You should have received all of the following components in the Treo box:

Hardware
- Treo handset
- AC charger
- USB HotSync® cable
- headset
- electrical socket adapter(s) (if required in region)

Documentation and software
- Using Your Treo (this book)
- Synchronization software CD

Treo handset features

The following illustrations show the locations and names of the physical features of the Treo. Refer back to these illustrations while following the instructions in this guide.

A. Antenna
B. Wireless Mode button
C. Infrared (IR) port
D. Ringer switch
E. Stylus
F. Expansion card slot
G. SIM slot
Be careful not to scratch or crush your Treo’s touchscreen. Do not store it in a place where other items might damage it.

IMPORTANT: Treo’s speaker includes a large magnet, so be sure not to store your Treo near credit cards or other items that could be demagnetized.

A. SIM slot  
B. Camera lens  
C. Speaker  
D. Reset button  
E. Reset tool (within stylus)  

A. Phone receiver  
B. LED (Wireless Mode and charge indicator)  
C. Volume buttons  
D. Phone  
E. Calendar  
F. Headset jack  
G. HotSync and power supply connector  
H. Microphone  
I. Messaging  
J. Screen on/off button  
K. 5-way navigation control
Charging the battery

Before using your Treo, you need to charge the battery. It may not turn on at all when you first remove it from the box. We recommend three hours for a full charge, or until the LED is solid green.

1. Plug the AC charger into a wall outlet. If necessary, connect an adapter.
2. Connect the charger cable to the bottom of the Treo with the word UP facing the same way as your Treo screen.
3. To confirm your Treo is charging, check the LED.
   - When the LED is solid red, your Treo is charging.
   - When the LED turns solid green, your Treo is fully charged.
   - If the LED does not turn on when you connect your Treo to the charger, double-check the cable connection and the electrical outlet to which it is connected.

After you turn on your Treo, the onscreen battery gauge displays power status:
   - Full battery icon •: Battery is charged
   - Partial battery icon •: Battery has some power and is not charging
   - Empty battery icon •: Battery needs charging immediately
   - Red lightning bolt •: Charging
   - Green lightning bolt with full battery •: Fully charged

Inserting the SIM card

Your Subscriber Identity Module (SIM) card contains account information such as your phone number and voicemail access number. To use the phone, email, or web features of your Treo, you need to insert the SIM card. If a SIM card did not come with your Treo, your mobile service provider will give you one when you subscribe. If you have an older, 5-volt SIM card, you should request a newer, 3-volt SIM. This Treo is not compatible with older 5-volt SIM cards.

1. Slide the SIM tray out of the Treo.
2. Insert the SIM card into the SIM tray by aligning the notches until you feel it lock into place.
3. Slide the SIM tray back into the Treo.
4. If your SIM card is not already activated, follow the activation steps provided by your mobile service provider or contact them directly for assistance. If you want to use email, web browsing, and MMS, be sure to confirm that your SIM card is activated for data services.

Your mobile service provider may already have inserted the SIM card into your Treo. In that case, skip to page 14.

To remove the SIM card, pull the SIM tray out of the slot and remove the card from the tray.
Turning Treo on and off

You can use the Palm OS features of your Treo independently of the wireless features and applications. Therefore, the screen and Wireless Mode are designed to be turned off and on separately.

Turning the screen on and off
1. Press the Screen button  to turn on the screen.
2. Briefly press the Screen button  to turn off the screen.

Turning Wireless Mode on and off

Wireless Mode allows your Treo to connect to a mobile network so that you can make and receive phone calls and use other wireless services.
1. Press and hold the Wireless Mode button  to turn on Wireless Mode. You will hear a series of ascending tones. When Wireless Mode is on, your Treo connects to a mobile network, and you can use the phone and Internet features (if supported by the local network).
2. Press and hold the Wireless Mode button  again to turn off Wireless Mode. You will hear a series of descending tones. When Wireless Mode is off, your Treo does not have a connection to any mobile network. You can still use the organizer and other Palm OS features. This is ideal for airplane flights and for maximizing battery life.

Making your first call

We recommend that you charge your Treo for a full three hours (or until the LED is solid green) before using it for the first time.
1. Press and hold the Wireless Mode button . You will hear a series of ascending tones.
2. If a Welcome screen appears, follow the onscreen instructions to set up your Treo.
3. Allow the Treo to complete a network search. The search may take several seconds. When it is complete, the network status icon appears in the upper right.
4. If prompted for a PIN, enter it on the PIN screen. The default PIN is often 1234. Otherwise, your mobile service provider may have given you some documentation with this information. Contact your mobile service provider for help.
5. Press Phone .
6. Using the number pad on the Treo keyboard, type the desired phone number.
7. Press Center to dial.
8. When your call is complete, use the 5-way navigation control to choose Hang Up.

If No Service appears in the upper left, you are out of a wireless coverage area. If you believe you are in a wireless coverage area and this problem persists, contact your mobile service provider for assistance.

If the Welcome screen does not appear, recalibrate the touchscreen. This ensures that the screen responds accurately to taps (see page 133).

Learn how to quickly redial your most recent calls on page 38.
Adjusting call volume
While a call is in progress, press the volume buttons on the side of your Treo to adjust call volume.

What's my number?
1. Make sure Wireless Mode is on (see page 14).
2. Press Phone.
3. Press Menu.
4. From the Options menu, choose Phone Info (/I). If your phone number is not displayed, exit Phone Info, and make sure your SIM card is properly inserted in the SIM slot. If your phone number still does not appear in Phone Info, consult your mobile service provider.

Making your first call

first day: learning the basics
Moving around the Treo screen

To move around the Treo screen, you can use the 5-way navigation control, or tap items on the screen with the stylus. With use, you will find your own favorite way to scroll, highlight, and select menu commands.

The 5-way navigation control includes Right, Left, Up, Down, and Center buttons.

A. Up
B. Down
C. Left
D. Right
E. Center

Scrolling through screens

As on a computer, you scroll on the Treo to move from field to field, or page to page, or in some cases to highlight an item or option in a list. There are several methods of scrolling:

• Press the 5-way navigation control on the front of the Treo. Pressing Right ⏏, Left ⏎, Up ⬆, and Down ⬇ moves to the next field, button, or action in that direction.

• Tap an onscreen scroll arrow:

  ![Scroll Arrows]

  • Press Option ⬇ and Up ⬆ or Down ⬇ to scroll to the next page of information within the current record.
  • When inside a text field, press Up ⬆ and Down ⬇ to scroll through the text.
  • Drag the slider of an onscreen scroll bar.

Highlighting items

The 5-way navigation control lets you highlight items before launching or selecting them.

• When an onscreen button (OK, Cancel, etc.) or pick list is highlighted, the button acquires a blue glow around its border.

• When a phone number, email address or web link is highlighted on a web page or in a message, the text appears in reverse type (light text on a dark background).

• When an entire text entry field is highlighted, you can press Center to edit the text. After you edit the text, press Center again to highlight the entire field.
You can also use the stylus to highlight text on the screen. When text is highlighted it appears in reverse type.

- Drag the stylus across the text you want to highlight.
- Double-tap a word to highlight it.
- Triple-tap a line of text to highlight it.

### Accessing command buttons

Command buttons, such as New, OK, and Details appear at the bottom of the screen. In many cases you can jump directly to these buttons instead of scrolling to them.

- From a list screen, such as the Contacts list or Mail inbox, press Right to jump to the first button.
- From a screen where you create or edit entries, such as Edit Contacts or Day View in Calendar, press Center to jump to the first button.
- From a dialog box, such as the Edit Categories, press Right to scroll to the first button, or press Option then Return for OK, or Option then Backspace for Cancel.

### Choosing or activating items

After highlighting an item with the 5-way navigation control, you can choose or activate it by pressing Center. You can also choose an item by tapping it with the stylus.

### Selecting menu items

Many applications have menus to provide access to additional features. These menus are usually hidden from view, but they appear when you press Menu. To get the most out of your Treo, it’s a good idea to familiarize yourself with the additional features available through the various application menus.

1. Press Menu to display an application’s menus.
2. Press Right and Left to switch between menus.
3. Press Up and Down to highlight a menu item.
4. Press Center to choose the menu item, or press Menu to close the menu and cancel your selection.

#### Choosing options in a pick list

A range of options is often presented in a type of menu called a pick list, which can be identified by a downward-pointing arrow. Pick lists are different from the application menus described above.

- Use the 5-way navigation control to highlight the pick list, then press Center to display the items in the list. Press Up and Down to highlight the item you want, then press Center to accept your selection.
- To exit the pick list and cancel your selection, press Left or Right.
- Use your stylus to tap the pick list, then tap the item you want from the list.
Using the keyboard

When using the keyboard, most people find it easiest to hold the Treo with two hands and use the tips of both thumbs to press the keys, as shown above.

A. Option
B. Shift/Find
C. Alt
D. Space
E. Applications Launcher
F. Menu
G. Return
H. Backspace

Using the keyboard backlight
- To turn on the backlight, press Option \( \text{option} \) then \( \text{option} \). The backlight may not be visible in bright sunlight.
- The backlight will turn off if the keyboard is not in use.

Entering lowercase and uppercase letters
- To type lowercase letters, press the desired keys.
- To type an uppercase letter, press Shift \( \text{shift} \), then type a letter. You don't need to hold down Shift while typing a letter.
- To turn Caps Lock on, press Shift \( \text{shift} \) twice. To turn it off, press Shift \( \text{shift} \) again. When Caps Lock is on, this symbol appears in the lower right:

Entering numbers, punctuation, and symbols that appear above the letters on the keys
- Press Option \( \text{option} \), then press the key with the desired character shown above the letter. You don't need to hold down Option while pressing the second key.
- To turn Option Lock on, press Option \( \text{option} \) twice. To turn it off, press Option \( \text{option} \) again. When Option Lock is on, this symbol appears in the lower right:

Entering other symbols and accented characters
1. Type the character that corresponds to the symbol or accented character you want. See the table on the next page.
2. Press Alt \( \text{alt} \).
3. Press Up \( \uparrow \) or Down \( \downarrow \) to highlight the desired character.
4. Press Center to insert the character, or just continue typing the next character.
Launching applications

Each of the three application buttons on the front of the Treo can be used to launch two applications. To access a button’s primary application, simply press the button. To access a button’s secondary application, press Option , then press the application button. The fourth button turns the screen on and off, and controls the keyguard.

Your mobile service provider may have customized the applications associated with each button.

You can also customize the buttons yourself; see page 117 for details.
Setting up your computer

Synchronization lets you enter information on your computer (using Palm Desktop or Microsoft Outlook for Windows) and then efficiently transfer that information to your Treo. At the same time, changes you make on the Treo are transferred to Palm Desktop or Microsoft Outlook. Even if you manage all your contacts on your Treo, synchronization is a great way to back up your data.

Before you can synchronize, you need to install the Palm Desktop synchronization software on your computer. Even if you already own a Palm Powered device and have installed a previous version, you must install the software that comes on the CD with your Treo.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 98SE, Me, 2000, or XP*</td>
<td>• 32 MB of memory&lt;br&gt;• 30 MB of free hard disk space&lt;br&gt;• CD-ROM drive&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td>• available USB port&lt;br&gt;• USB HotSync cable (included with your Treo)</td>
</tr>
<tr>
<td>Windows NT 4</td>
<td>• 32 MB of memory&lt;br&gt;• 30 MB of free hard disk space&lt;br&gt;• CD-ROM drive&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td>• available serial port&lt;br&gt;• serial HotSync cable (sold separately)</td>
</tr>
<tr>
<td>Macintosh OS 10.1-10.3.x*</td>
<td>• 32 MB of memory&lt;br&gt;• 25 MB of free hard disk space&lt;br&gt;CD-ROM drive&lt;br&gt;</td>
</tr>
<tr>
<td></td>
<td>• USB port&lt;br&gt;• USB HotSync cable (included with your Treo)</td>
</tr>
</tbody>
</table>

*later versions may also be supported

In Palm OS, you access all available applications through a screen called the Applications Launcher:
1. Press Applications Launcher.
2. Use the 5-way navigation control to highlight the application you want to use.
3. Press Center to launch the selected application.

[Table showing button, primary application, and secondary applications]

Press Applications Launcher repeatedly to cycle through different categories of applications.

In the Applications Launcher, you can type the first few letters of the application’s name to highlight it. For example, if you type c it highlights Calendar, then if you type i it highlights CityTime. If you pause and then type i, it highlights the first application that starts with i.

IMPORTANT: If you’re upgrading from another Palm Powered device, follow the upgrade steps on page 128 before you set up your computer for your new Treo.

If you are synchronizing with a computer that is running Windows NT 4, you must use a serial HotSync cable, available for separate purchase at www.palmOne.com.
Installing the Palm Desktop synchronization software on your computer

Your computer needs to have all its resources available to install the software. Follow these guidelines for a successful installation:
1. Exit any applications that are currently running on your computer, including those running in the background.
2. Insert the CD that came with your Treo into the CD-ROM drive on your computer. If you are installing on a Macintosh, double-click the CD icon on the desktop, then double-click the Installer icon.
3. Follow the onscreen instructions of the installation program. Click Install Now to install the Palm Desktop software. Please note these important points about the installation process:
   • If a language selection screen appears, click the same language you use on your Treo.
   • During the installation process, you will be prompted to synchronize for the first time.

Connecting your Treo to your computer

1. Plug the AC charger into a wall outlet. If necessary connect an adapter.
2. Connect the charger to the short end of the HotSync cable. Be sure to match the sides of the connectors labeled UP.
3. Plug the USB HotSync cable into an available USB port on your computer.
4. Connect the long end of the HotSync cable to the bottom of your Treo with the button facing up.

For best performance, plug your USB synchronization cable directly into a USB port on your computer. If you use a USB hub, make sure it is a powered hub.
Synchronizing contacts and other personal data

Before you can synchronize your contacts and other personal data, you must install the Palm Desktop software from the CD that came with your Treo. See page 29 for instructions.
1. Connect your Treo to your computer as described on page 26.
2. Press the HotSync button on the cable.
3. Wait for your Treo to display a message indicating that the process is complete.
   • If nothing happens, make sure that you installed the Palm Desktop software and that the HotSync Manager application is running on your computer ( ).
   • If you want to synchronize data with applications other than Palm Desktop or Microsoft Outlook, you need to purchase additional third-party conduit software.
   • If you have any problems performing a HotSync operation, see pages 137-139 for troubleshooting suggestions.

Battery life

Battery life depends on individual usage. When used as a phone, your Treo battery provides approximately 6 hours of talk time or 10 days of standby time. When used as an organizer only (no phone), the battery provides about 10 days of normal use.

Maximizing battery life

You can increase the life of your Treo battery by following a few easy guidelines. Remember that battery life depends on how you use your Treo.
• Charge your Treo whenever you're at your desk. The Li-Ion battery in your Treo has a much longer useful life when it is topped off frequently, versus charging it after it is fully drained.
• The wireless features (phone, email, messaging, and web) of your Treo generally consume more power than its organizer features. However, if you spend a lot of time using the camera, games, media players, eBooks, or other Palm OS applications, keep an eye on the battery level and charge when necessary.
• If you don’t plan to use the wireless features on your Treo for a while, you may want to turn off Wireless Mode (see page 14). You can forward calls to a different number or let all calls be picked up by voicemail (see page 45).
• As with any mobile phone, if you are in an area with no wireless coverage, your Treo searches for a signal, which consumes power. If you cannot move to an area of better coverage, you may wish to temporarily turn off Wireless Mode.
• Use the keyboard backlight (see page 22) only when you need it.
• Turn down the screen brightness (see page 114).
• Decrease the Auto-off setting in General Preferences (see page 120). This turns off your screen automatically after a shorter period of inactivity.
Where to learn more

A quick introduction to your new Treo

- Tutorial: The Tutorial teaches you how to use many features of your Treo. It is already installed on your Treo and you can launch it any time.

While using your Treo

- Tips: Many of the built-in applications include helpful tips for getting the most out of your Treo. To view these tips, launch an application, press Menu, then from the Options menu, choose Tips.
- Information: Many screens have an Information icon in the upper-right corner. Tap the Information icon with your stylus to learn about the tasks you can perform in that dialog.
- Online support from palmOne: For up-to-date downloads, troubleshooting and support information, check out www.palmOne.com/support/treo600.

If you need more information

- Books: Many books on Palm Powered devices are available in local or online book retailers (look in the computers section).
- Online forums: Consult online Treo user discussion groups to swap information and learn about areas you may find nowhere else.
- Customer service from your mobile service provider: For questions about your mobile account or features available on the network, contact your mobile service provider for the latest information and help.
Phone overview

The Phone application lets you make and receive calls, store information about your contacts, and store Favorites for contacting people and launching applications. Be sure you know how to turn on Wireless Mode before reading this section (see page 14).

Accessing the Phone application

• Press Phone .

You can monitor the status of several items, using icons at the top of the Phone screen:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network name</td>
<td>Displays the name of a mobile service provider when Wireless Mode is on and you are in a coverage area. If you are outside a coverage area, No service or SOS Only appears instead.</td>
</tr>
<tr>
<td>Call forwarding</td>
<td>Appears when call forwarding is active.</td>
</tr>
<tr>
<td>Voicemail</td>
<td>Appears when you have voicemail. Some networks use a full-screen alert instead. Call your mobile service provider for more information.</td>
</tr>
<tr>
<td>ALS</td>
<td>Appears when ALS, Alternate Line Service, is active. This feature may not be available on all accounts or regional networks. Contact your mobile service provider for more information.</td>
</tr>
<tr>
<td>Signal strength</td>
<td>Appears when Wireless Mode is on. The bars display the signal strength. The stronger the signal, the more bars appear. If you are outside a coverage area, no bars appear.</td>
</tr>
<tr>
<td>GPRS</td>
<td>Appears when Wireless Mode is on and a GPRS network is within range. Some service providers do not show the triangle.</td>
</tr>
<tr>
<td>Battery charge</td>
<td>Displays the battery charge status. As the battery drains, the icon changes from blue to clear, and then to red when it’s time to recharge.</td>
</tr>
<tr>
<td>Treo battery charging</td>
<td>Appears when your Treo battery is charging.</td>
</tr>
<tr>
<td>Treo battery fully charged</td>
<td>Appears when your Treo battery is fully charged.</td>
</tr>
</tbody>
</table>

To display details about your battery power, tap the battery icons at the top of the screen.

If ALS is active and available, you can press and hold # to switch lines.
Dialing calls

Your Treo offers several options for making phone calls. As you get familiar
with your Treo, you'll discover which method you prefer.

Dialing with the keyboard
1. Press Phone.
2. Using the numbered keys on the keyboard, start typing a phone number.
   You do not need to press Option to access the numbers on the keyboard.
3. Press Center to dial.

Dialing by contact name
Before you can dial a call by contact name, you must create some contacts
(see page 47), or import them with a HotSync operation (see page 30) or
from your SIM card (see tip on page 48). The first time you display the
Contacts list, Treo asks if you would like to import any numbers from your
SIM card into your Contacts list.
1. Press Phone.
2. Use the 5-way navigation control to access the Contacts list.
3. Using the keyboard, begin typing one of the following for the contact you
   want to call:
   • First initial and last name
   • First name
   • Last name
4. Choose the number you want to dial.
5. Press Center to dial.

To start another search, press Backspace to delete letters you've entered. Or, just press Phone to start all over.

Dialing with a Favorites button
Before you can use Favorites buttons, you must create some Favorites
entries. See page 49.
1. Press Phone.
2. Use the 5-way navigation control to access your Favorites buttons.
3. Highlight the desired button.
4. Press Center to dial the selected button.

Dialing using the onscreen Dial Pad
1. Press Phone.
2. Tap the onscreen Dial Pad to enter the number.
3. Press Center to dial.

You can paste numbers directly into the Dial Pad view. Copy a number from
another application, then

You can begin a Name
Lookup immediately from
the Main view in the Phone
application. From the
Options menu, select
Display Preferences, and
choose Typing Starts
Contacts Search.
Receiving calls

Receiving calls

To receive calls, Wireless Mode must be on. This is different from having just the screen turned on (see page 14).

To answer a call, do one of the following:
• Using the 5-way navigation control, choose the onscreen Answer button.
• If the headset is attached, press the headset button.

To ignore a call and send it to voicemail, do one of the following:
• Press Backspace.
• Using the 5-way navigation control, choose the onscreen Ignore button.

To silence the ringer while your phone is ringing:
• Press the volume buttons or any key on your Treo except the 5-way navigation control, Space, Return, or Backspace.
• To immediately silence all system sounds including the ringer, slide the ringer switch to Sound Mode Off.

When you silence the ringer, you can either answer the call or let it ring through to voicemail.

If audio (MP3 music, for example) is playing, and a call arrives, you can still hear the phone ringing softly. To answer the call, do one of the following:
• Using the 5-way navigation control, choose the onscreen Answer button.
• Press the headset button (if headset is attached).

The audio continues playing but you won't hear it during your call.

Dialing from a web page or text message

Treo recognizes most phone numbers that appear in web pages or text messages.

1. Use the 5-way navigation control to highlight the phone number you want to dial in the web page or text message.
2. Press Center to dial.

Redialing the last number you called

Do either of the following to redial the last number you called:
• Press Phone, then press Center to display a list of your most recently dialed numbers.
• Press Phone, then use the 5-way navigation control to launch Dial Pad. Choose Dial to display the last number you dialed.
• Press Phone, then press Menu. From the Views menu, choose Call Log (V). This view shows all your recent calls in chronological order.

If you can't highlight and dial a phone number on a web page or in a text message, using the 5-way navigation control or stylus, it means that Treo does not recognize it as a phone number.

See a photo of the person calling you! Learn how to assign a caller ID picture on page 112.

To prevent calls from accidentally being answered while the phone is in a pocket or briefcase, you can disable the touchscreen when an incoming call arrives (see page 121).
Using voicemail

Setting up voicemail
1. Turn on Wireless Mode, as described on page 14.
2. Press Phone .
3. Use the 5-way navigation control to access Favorites.
4. Choose the voicemail Favorites button.

Retrieving voicemail messages
1. Press Phone .
2. From the Phone application Main view, Dial Pad, or Favorites, press and hold 1 on the keyboard. Treo dials your mobile service provider’s voicemail system.
3. Enter your voicemail password using the Treo keyboard, or choose Extra Digits if you defined this option (see page 51 for information on editing Favorites buttons). Remember, you do not need to press Option to type numbers, *, or # while on an active call.

Voicemail notification
When you have a new voicemail message, you are notified with an alert. A voicemail icon may also appear near the top of your screen (this feature is not supported by all mobile networks).
Managing active calls

When you make or receive a call, the Active Call view appears. Use the 5-way navigation control to access the onscreen buttons in this view:

- **Hang Up** (or pressing Backspace): Ends the call immediately. You can also press the headset button (if the headset is attached).
- **Spkr-Phone** (or pressing Space): Switches to the personal speakerphone.
- **Hold** (or pressing Period): Places the current call on hold.
- **Dial Pad**: Opens the Dial Pad so you can manually dial additional numbers.
- **Mute**: Mutes the Treo microphone so you cannot be heard.
- **Add Call**: Lets you place another call while keeping the first call active. First choose Hold, then choose Add Call.
- **Extra Digits**: Dials any extra digits (such as a password or extension) that you assigned to a Favorites button. See page 50 for information on creating a speed dial Favorites button.

A. Caller’s name and number  
B. Current duration of call  
C. Hang up immediately  
D. Switch to speakerphone  
E. Place current call on hold  
F. Mute the microphone  
G. Open Dial Pad view

More ways to manage calls

Treo offers many advanced telephone features, including call waiting, conference calling, and call forwarding.

Making a second call

You can make a second call while your first call is still active.

1. After dialing the first number, use the 5-way navigation control to choose Hold.
2. Use the navigation control to choose Add Call.
3. Dial the second number using Favorites, Contacts, Dial Pad, Call Log, or Redial list (see pages 36-38).

The Active Call view now includes two status lines, each representing one of the calls. To switch between the two calls, choose Swap.
Answering a second call (call waiting)
When you are on an active call, you can receive a second call. When the second call comes in, the Call Waiting dialog appears, giving you the following options for handling the second call:
• To place the current call on hold and answer the new call, use the 5-way navigation control to choose Answer.
• To send the new call to voicemail, use the navigation control to choose Ignore.

Making a conference call
You can join a total of five other calls in a conference session, provided that your network and service plan include 6-way conferencing. Please contact your mobile service provider for more information. Minutes in your mobile account may be deducted for each active call you place.
1. While the first call is active, place or answer a second call.
2. Use the 5-way navigation control to choose Conf. This joins the two active calls in a conference session.
3. Repeat this process to add other calls to the conference call.
4. To end the conference, use the navigation control to choose Hang Up and end all the calls.

Forwarding all calls
You can forward all of your calls to another telephone number. You can also selectively forward certain calls (see page 46). Keep in mind that your mobile service provider might charge you for forwarded calls.
1. Press Phone  
2. Press Menu  
3. From the Options menu, choose Call Preferences (/A).
4. Choose the Forward all calls pick list.
   • If the forwarding number appears in the pick list, select the number.
   • If the forwarding number does not appear in the pick list, select Edit Numbers, then choose New. Enter a forwarding number, including the area code or country code if it is different from your mobile phone number. Choose OK to finish.
5. Choose OK.
Managing contacts

Contacts is a view in Phone. If you are familiar with Palm Powered devices, you may recognize this application as similar to the Address Book on previous devices.

Adding a contact
1. Press Phone.
2. Use the 5-way navigation control to access the Contacts list.
3. Choose New Contact.
4. Use the 5-way navigation control to move between fields as you enter information.
5. To place the entry in a category or mark it private, choose Details.
6. To add a note to an entry, choose Note.
7. After you enter all the information, choose Done.

Forwarding calls under certain conditions
You can forward calls to another number when the line is busy, a call is unanswered, Wireless Mode is off, or you are outside a coverage area.

1. Press Menu.
2. From the Options menu, choose Call Preferences (/A).
3. Choose the Forward all calls pick list, then select Don’t forward calls.
4. Choose any of the following pick lists:
   • When busy: Forwards calls if the phone is busy.
   • Not answered: Forwards calls instead of sending to voicemail.
   • Off/No service: Forwards calls when your Treo is not connected to a mobile network.

   If the forwarding number appears in the pick list, select the number. If the forwarding number does not appear in the pick list, select Edit Numbers, then choose New, enter a forwarding number, and choose OK to finish.

5. Choose OK.

Call Barring
Call Barring lets you prevent unauthorized calls on your Treo. This feature may not be available on all mobile networks. Contact your mobile service provider for more information.

You must enter your Call Barring password every time you change your Call Barring preferences. Contact your mobile service provider if you do not know this password.

1. Press Menu.
2. From the Options menu, choose Call Barring.
3. Choose the onscreen pick lists, then select your Call Barring preferences.
4. Choose OK.

If you have several contacts to enter, it’s more efficient to use the Palm Desktop software or Microsoft Outlook on your computer and then synchronize data between the Treo and your computer. For more information, see page 30.

In the Contacts View, Up and Down move to the previous or next Contacts record.

Be sure to label your contacts’ mobile numbers correctly. The SMS application (see page 64) will only look up numbers labeled as Mobile.

In the Contacts View, Up and Down move to the previous or next Contacts record.

Be sure to label your contacts’ mobile numbers correctly. The SMS application (see page 64) will only look up numbers labeled as Mobile.

In the Contacts View, Up and Down move to the previous or next Contacts record.

Be sure to label your contacts’ mobile numbers correctly. The SMS application (see page 64) will only look up numbers labeled as Mobile.
Defining Favorites buttons

Treo provides 50 programmable Favorites buttons for quick access to the following common tasks:

- Dialing a phone number (speed dial)
- Launching an application
- Accessing a web page
- Addressing a text message
- Accessing voicemail (preset on Treo)

Your mobile service provider may include special Favorites buttons on your Treo that are customized for their services.

When you are in the Main, Favorites, or Dial Pad view, you can press and hold a Quick Key to launch the Favorite associated with that key. Quick Keys are optional, must be letters, and are not case sensitive.
Creating a speed dial Favorites button
1. Press Phone.
2. Use the 5-way navigation control to access your Favorites buttons.
3. Choose a blank button.
4. Choose the Types pick list, then select Speed Dial.
5. Enter a label for the favorite:
   • If the entry is for an existing contact, choose Lookup. Start typing the last name of the contact, then select the contact when it appears in the Lookup list.
   • If the entry is for a new contact, type the Label, press Down and type the Number.
6. (Optional) Enter a Quick Key. When you are in the Phone application, you can press and hold the Quick Key to instantly launch the favorite.
7. (Optional) Choose More, and select advanced options:
   • Extra Digits: Lets you define additional digits to dial, such as a password or extension.
   • Dial Extra Digits Automatically: Dials pre-defined Extra Digits immediately after dialing the phone number, when checked.
   • Ringtone: Assigns a special ringtone for incoming calls from that contact.
   • Image: Assigns a Caller ID picture that displays when that person calls.
8. Choose OK.

Creating an application, message or web link Favorites button
1. Press Phone.
2. Use the 5-way navigation control to access your Favorites buttons.
3. Choose a blank button.
4. Choose the Types pick list, then select Application, Message or Web Link.
5. Enter a label for the favorite, and enter any other necessary information on the screen.
6. (Optional) Enter a Quick Key that launches the favorite when pressed and held.
7. Choose OK.

Editing or deleting an existing Favorites button
1. Press Phone.
2. Use the 5-way navigation control to access your Favorites buttons.
3. Highlight the Favorites button you want to edit or delete.
4. Press Menu.
5. From the Edit menu, choose Edit Favorites Button (/E).
6. Make the desired changes. For example, you can add a Quick Key shortcut to any favorite. When you press and hold the assigned letter from within the Phone application, the favorite launches.
7. To delete the entry, choose Delete.
8. Choose OK.

To see all the contact numbers for the selected person or business, highlight the Favorite button and press Space.

To add a photo caller-ID image, a special ringtone, and extra digits, choose More.

You can also organize your Favorite buttons on different pages. From the Edit menu, choose Edit Favorites Pages. You can edit but not delete the voicemail entry.
Using a phone headset

You can connect a phone headset for hands-free operation. If you need to use your phone while driving and this is permitted in your area, we recommend using a phone headset.

A. Speaker
B. Microphone
C. Headset button

You can press the headset button to perform any of the following tasks:
- answer an incoming call
- answer a call-waiting call
- switch between two active calls
- hang up a single call

Headset specifications

Your Treo uses a 2.5mm, 3-pin headset connector. Your Treo works with headsets that are designed for this type of connector. When in doubt, ask the third-party headset manufacturer if their product is compatible with Treo phones. If you hear a headset buzz or poor microphone performance, your headset may be incompatible with Treo.

Browsing the web

Blazer Web Browser on your Treo provides quick and easy access to web pages. You can view the regular sites you use today, including those with security and advanced features like JavaScript and frames. To browse the web, you must activate data services from your mobile service provider.

Viewing a web page

1. Make sure Wireless Mode is turned on, as described on page 14.
2. Press Applications Launcher , then choose Blazer.
3. Navigate to the web page you want:
   - To view a portal of mobile content designed specifically for your Treo, choose .
   - To go to any web page on the Internet, choose .
   - If you browse to a secure web page, a Lock icon appears.
   - To view the previous or next page, choose or .
   - To refresh the page with the latest content available from the Internet, choose .

Navigating in Optimized Mode

Blazer uses a patent-pending technology to optimize web pages for your Treo. By default, the browser reformats web pages into one column on your screen. This way, you can see most content without needing to scroll left or right.
- Press Up or Down to move through a web page.
- Press Left or Right to move between links on the page. To follow a link to another web page, highlight the link and then press Center. You can also tap the link on the screen with your stylus.
Navigating in Wide Page Mode

Some web pages, such as maps, are easier to view without the optimization done in Optimized Mode. You may want to view these pages in Wide Page Mode. This mode presents the web page as you would expect to see it on your computer’s screen.

1. Go to the page you want to view.
2. Press Menu .
3. From the Page menu, choose Wide Page Mode (/W).
   - Press Up , Down , Left , or Right to scroll through the wide page.
   - To follow a link to another web page, tap the link with your stylus.

Creating a bookmark

Bookmarks let you instantly access a web page, without needing to type the address every time. Blazer can store up to 100 bookmarks or saved pages, allowing you to open your favorite web pages quickly. Remember, a Blazer bookmark is different from a Favorite (see page 50).

1. Go to the page you want to bookmark.
2. Press Menu .
3. From the Page menu, choose Add Bookmark (/A).
4. If desired, change the Name and Description.
5. Choose OK
6. Use the stylus to drag and drop the new bookmark into a slot on the current page. To move the bookmark to a different page, drag and drop it on the page icon .
7. Choose OK.

Saving a page

Blazer lets you save a page for offline viewing, so you don’t need an Internet connection to view it later.

1. Go to the page you want to save.
2. Press Menu .
3. From the View menu, choose Save Page.
4. Choose OK
5. Use the stylus to drag and drop the new bookmark into a slot on the current page. To move the bookmark to a different page, drag and drop it on the page icon .
6. Choose OK.

Viewing bookmarks or saved pages

Bookmarks and saved pages both appear in Bookmark view. Saved pages are indicated by a small triangle in the upper-right corner of the bookmark.

1. Choose the Bookmarks view icon .
2. Choose the bookmark or saved page you want to view.
3. If desired, change the Name and Description.
4. Choose OK
5. Use the stylus to drag and drop the new bookmark into a slot on the current page. To move the bookmark to a different page, drag and drop it on the page icon .
6. Choose OK.

Always using bookmarks?

Make Bookmark View the default view when you launch the browser. From the Options menu, choose Preferences, then select the Bookmarks icon as your Initial View.
Browsing the web

Downloading files from a web page
Blazer lets you download files that are useable on your Treo, such as new applications or MIDI ringtones. When you download a file, it is automatically sent to the application that can use the file. Note: Only certain images tagged specifically for download can be downloaded by Blazer.
1. Go to the page that contains the link to the file you want to download.
2. Press Left or Right to highlight the link to the file, then press Center to initiate the download process.

Navigating web sites with split pages (Frames)
Some web sites split their pages into separate areas, each with their own scroll bars. You can navigate these sites more easily by "zooming in" on one of the separate areas. To do this:
1. Tap inside the area of the split page you want to make larger. Make sure you tap on an area that is not a link, otherwise, you will navigate to that link.
2. Tap the magnifying glass icon in the navigation bar. This will make the area you tapped on the entire page. Note: This icon will only appear if you are on a page that is split into separate areas.

Copying text from a web page
You can copy text from a web page and paste it in other applications.
1. Use the stylus to highlight the text you want to copy.
2. Press Menu.
3. From the Edit menu, choose Copy (/C).
4. Go to the application in which you want to paste, then position the cursor where you want to paste the text.
5. Press Menu.
6. From the Edit menu, choose Paste (/P).

Editing or deleting a bookmark or saved page
1. From the Bookmarks view, press Menu.
2. From the Bookmarks menu, choose Edit Bookmarks.
3. Choose the bookmark you want to edit or delete.
4. Enter the desired changes.
5. Choose OK.

Arranging bookmarks and saved pages
Blazer includes 10 pages so that you can arrange bookmarks and saved pages in a logical fashion. For example, you can store travel links on one page, stock links on another, and business links on third page.
1. From the Bookmarks view, press Menu.
2. From the Bookmarks menu, choose Edit Bookmarks.
3. Type a new title for this page.
4. Use the stylus to drag and drop bookmarks into different slots on the current page. To move a bookmark to a different page, drag and drop it on the page icon.
5. Choose OK.

Lots of pretty graphics slowing you down? Browse the web faster by turning off images. From the Options menu, choose Preferences, and then check the Don’t Show Images box.

If Blazer does not recognize a phone number as dialable, you can copy the phone number (as text) and paste it into the Phone Dial Pad (see tip on page 37).
Using the History list

The History list stores the addresses of the last 100 pages you visited. Items in the History list are sorted chronologically.

1. From the Page view, press Menu .
2. From the Page menu, choose History.
3. Press Down ▼ to navigate through the list.
4. Choose the web page you want to load.

Finding text on a web page

1. From the Page view, press Menu .
2. From the Page menu, choose Find Text on Page.
3. Type the text you want to find.
4. Check or uncheck the Wrap Search box to indicate whether you want the search to wrap from the end of the page to the beginning when the end is reached.
5. Choose Find to start the search.

Customizing your Blazer Web Browser settings

1. Press Menu .
2. From the Options menu, choose Preferences.
3. Set any of the following preferences:
   • Initial view: Determines which view displays every time you launch Blazer.
   • Don’t show images: Selects whether you want images to appear when you load a web page. If you don’t view images, web pages will load faster. If you choose not to view images, you can still see any image by choosing the placeholder box on the web page.
4. Choose Advanced and set any of the following preferences:
   • Set limit on memory for storing recently viewed pages (cache): Sets the amount of memory used for your cache. Pages are cached so they load faster the next time you view them.
   • Memory Management: Enables you to free up memory on your phone by clearing the memory for recent pages, history, and cookies.
   • Set Proxy: Sets up a proxy server to access the Internet. If your connection requires a proxy server, please contact your Internet service provider or IT administrator for this information.
   • Accept cookies: Allows some web sites to store personalized information on your Treo. Some sites do not work properly unless you select this option.
5. Choose OK.
Taking pictures with the camera

Your Treo includes a camera that lets you take pictures, send them to other people as attachments or picture messages, and use them to personalize your device (such as wallpaper or picture caller ID; see page 112 for details).

You can move pictures to a Windows computer by performing a HotSync operation. Pictures are 12-bit color at a maximum of 640×480 resolution (0.3 megapixels).

Sending a picture
You can send a picture to other picture-enabled mobile phones or to an email address.
1. From the Pictures view, choose the picture you want to send.
2. Choose Send.
3. If a dialog appears, choose the application you want to use to send the picture.
4. When the sending application launches, address and send the message.

Viewing a picture
1. Choose the Pictures view icon.
2. Choose the picture you want to view.
3. Choose Done.

Taking a picture
1. Press Phone.
2. Press Right to launch Camera.
3. Point the lens on the back of your Treo at the subject you want to photograph.
4. Press Center to capture the picture.
5. If desired, edit the picture name and category at the top of the screen.
6. Choose Save to keep the picture, choose Don’t Save to discard it, or choose Send to send the picture.

To send a picture to someone at the same time you save it, choose Send instead of Save.

You can reduce the size of an image before sending it. From the Picture menu, choose Downsize. Indicate whether you want to resize the original or save a reduced copy.

To view other full-size pictures, choose Prev or Next.

You cannot send pictures that appear with a lock icon in the Pictures view.

When using the camera in low light, you may see blue dots on the screen, especially in the darker areas. Once you capture the picture, image quality improves.
Taking pictures with the camera

Moving pictures
1. From the Pictures view, choose the picture you want to move.
2. Press Menu \(\text{Menu}\).
3. From the Picture menu, choose Move (/M).
4. Choose the category or expansion card where you want to move the picture.
5. Choose Move to finish.

Deleting a picture
1. From the Pictures view, choose the picture you want to delete.
2. Choose Delete.
3. If prompted, choose OK to confirm deletion.

Customizing your Camera settings
1. From any Camera view, press Menu \(\text{Menu}\).
2. From the Options menu, choose Preferences.
3. Set any of the following preferences:
   - Default name: Names a series of pictures to be captured, such as Seattle001, Seattle002, etc.
   - Category: The default category for newly captured pictures.
   - Picture size: The default size for newly captured pictures. Large is 640 x 480 pixels, small is 120 x 160 pixels.

4. Choose OK.

Viewing pictures on your computer (Windows only)
When you perform a HotSync operation, your Treo images are copied to your desktop computer. You can view these pictures in JPEG format, or email them to friends using your desktop email application.

1. Locate your Pictures folder. This is most likely at C:\Program Files\palmOne\Treo Pictures\(user name) or if you upgraded from another Palm Powered device, at C:\Program Files\Palm\Treo Pictures\(user name).
2. Double-click any file to launch it with the default picture viewing software on your Windows computer.
SMS

SMS messages are brief notes that you exchange with other mobile phones that have SMS capability (also known as short messaging). Long messages with more than 160 characters are split into several messages. Refer to your service plan for per-message pricing and availability.

Creating and sending a message
1. Make sure Wireless Mode is turned on, as described on page 14.
2. Press SMS  
3. Choose New.
4. If the intended recipient is in your Contacts list, start typing the first initial and last name (no spaces). Otherwise, type the full phone number or email address. Destination email addresses are included in the 160 character count.
5. Press Down . If you typed just a few letters of the recipient's name, choose the recipient's phone number or email address from the list that appears.
6. Type your message.
7. Choose Send.

Receiving messages
When your phone is on and in an area of wireless coverage, you will automatically receive SMS messages sent to you. You can configure your Treo to automatically notify you when new text messages arrive, using a ringtone and vibration or simply an onscreen alert.

From the New Message alert:
• To view your message(s), choose Go To.
• To dismiss the alert, choose OK. The message will go straight to the Inbox.
• To be reminded of the new message again in 5 minutes, choose Snooze.

Using links in messages
When you receive an SMS message that contains a telephone number, email address, or URL, you can dial the number, send an email message, or go to the web page immediately.
1. Choose a message from the list.
2. Choose the phone number, email address, or URL (appears as underlined blue text).
3. Your Treo automatically launches the appropriate application from the link.

Not all symbols available on your device may be used in text messages. The SMS application automatically replaces invalid characters before it sends your message.

You can address text messages to multiple recipients by separating the addresses with a space or a comma. If you address a single message to three people, you will be billed for three messages.

When entering a message, you can insert emotive symbols by choosing Emoticons or predefined QuickText phrases. To add a new phrase, select Edit QuickText from the list.

You can insert emotive symbols by choosing Emoticons or predefined QuickText phrases. To add a new phrase, select Edit QuickText from the list.

64 :: SMS

65 :: SMS
Chatting with SMS
When you exchange more than one SMS message with a single contact, your messages are grouped into a chat session. The upper part of the Chat view displays all messages you’ve exchanged with this contact, and the lower part provides a text entry area. You can carry on multiple chats at the same time and easily switch between them, using the pick list at the top of the screen.

1. From the Inbox, choose a chat.
2. Type your message.
3. Choose Send.

Customizing your SMS settings
1. Press Menu.
2. From the Options menu, choose Preferences.
3. Set any of the following preferences:
   • Messages: Your preferences for individual text messages.
     • Confirm message deletions: Indicate whether you want deletion confirmation messages to appear.
     • Return to list view after deletion: Indicate whether you want to return to the list view or the next item in the folder after deleting a message.
MMS

MMS (multimedia messaging) is used for messages consisting of pictures, text, and sounds presented as one or more pages. You can include any of the following items:

- **Ringtones**
  - MIDI: Up to 16-voice polyphony (Standard or SP-MIDI format), 64 KB per sound file
  - iMelody: Up to 64 KB per sound file
- **Sound clips**
  - AMR: Up to 30 seconds playback time, 64 KB per sound file
- **Pictures**
  - JPEG: Up to 640 x 480 pixels, 64 KB per image file
  - GIF: Up to 640 x 480 pixels, 64 KB per image file

Creating and sending a multimedia message
1. Press Applications Launcher ®.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the MMS icon.
4. From the MMS list view, choose New.
Viewing/playing a multimedia message
1. From the Inbox, choose the message you want to view.
2. If there are sounds or multiple pages, playback will begin immediately.
3. Use the onscreen controls to scroll to other pages and messages.
4. If a Sound icon appears, choose it to play or save the sound.
5. Choose OK.

A multimedia message may contain multiple pages. To navigate between pages or add a new one, choose the Page Selector arrows at the top of the screen.

To stop playback of a message, choose Play/Stop.

Receiving multimedia messages
You can automatically download new messages or have Treo notify you that a message is ready to download. In either case, an alert appears when you have a new message.

From the alert:
- To view your message(s), choose Go To.
- To dismiss the alert and view the message(s) later, choose OK.
- To be reminded again in 5 minutes, choose Snooze.

To delete an item from a message you’re creating, highlight it and then press Backspace.

You can expand and collapse header information by choosing one of the “full header” icons in the title bar of a message.

If you reply to a multimedia message with a text message, you’ll automatically be sent to the SMS application to compose your reply.

Responding to a multimedia message
1. From the MMS list view, choose the message you want to view.
2. Choose Respond.
3. Choose the appropriate action to reply, forward, or call.

Managing multimedia messages
You can rearrange messages in any folder using the Sort command.
1. From list view, press Menu ( ).
2. From the View menu, choose Sort by Name or Sort by Date.

In list view you can delete several messages at once from any folder using the Purge command.
1. From the MMS list view, press Menu ( ).
2. From the Message menu, choose Purge.
3. Choose the Purge pick list, then select a purge option.
4. Choose OK.

Receiving multimedia messages
You can automatically download new messages or have Treo notify you that a message is ready to download. In either case, an alert appears when you have a new message.

From the alert:
- To view your message(s), choose Go To.
- To dismiss the alert and view the message(s) later, choose OK.
- To be reminded again in 5 minutes, choose Snooze.
Customizing your MMS settings
1. Press Menu.
2. From the Options menu, choose Preferences.
3. Set any of the following preferences:
   • Automatically deliver messages: Indicate whether you want to automatically download incoming multimedia messages.
   • Even when roaming: Indicate whether you want to automatically download incoming multimedia messages while roaming.
   • Confirm message deletion: Indicate whether you want deletion confirmation alerts to appear.
   • Display alerts in Privacy Mode: Indicate whether you want the subject and sender’s name to appear in the notification alert.
   • Save copies of sent messages: Indicate whether you want to save copies of messages you send.
   • Connection Settings: Indicate whether you want to use the Automatic or Custom connection settings. If you choose Custom, choose Edit and enter your settings.
4. Choose OK.

Sending and receiving messages with Mail

If you have activated data services (such as GPRS), you’re ready to set up your Treo for email. These steps differ depending on who provides your email service.

• Mail: The built-in email application on Treo that provides wireless access to an existing POP3 email account. See the sections that follow for details.

• Other mobile email services: Your mobile service provider may offer a wireless email service to which you can subscribe with your service plan. Contact your mobile service provider for details.

• Third-party email applications: A number of third-party developers offer Palm OS email applications. Consult the email application’s documentation to learn how to set it up.

Setting up Mail
The first time you use Mail, you need to set it up on your Treo. If you have multiple email accounts, you can set up Mail to access more than one account. To use Mail, you must have:

• Mobile account with data services activated.
• Email account with an email service provider that supports the POP3 protocol. Examples include Earthlink, SBC and AT&T Worldnet. Contact your email provider to determine if your account is POP3 compatible. If not, contact your mobile service provider to learn about their corporate email solutions, or use a third-party solution.
1. Press Applications Launcher  
2. Choose the Mail icon.
3. Choose the pick list, then select your email service provider. If your email service provider is not listed, select Other.

4. Choose Next.

5. Type your Full Name (as you want it to appear when you send messages), your full email address, and your Password for this account. If you selected Other from the pick list earlier, choose the tabs for Server and Advanced, and enter the necessary information. If you do not have this information, contact your email service provider to obtain it. For SMTP, enter the regional SMTP server provided by your mobile service provider.

6. Choose OK to continue.

7. Choose Done.

Creating and sending messages

1. From the Inbox, choose New.
2. Begin typing the addressee's email address, first name, or last name. Mail remembers your most recent addressees and suggests choices. To accept a suggestion, press Down . To send to a different address, keep typing the email address or name.

3. Enter the subject and message text. To move between fields, press Up ▲ or Down ▼.
4. Choose Send to connect and send all messages immediately. Or, choose Send Later to put this message into your Outbox.

Attaching ring tones and images to your messages

1. Create the message to which you want to attach the item.
2. From the New Message screen, press Menu  
3. From the Options menu, choose Insert Attachment.
4. Choose the type of item you want to attach.
5. Choose the specific item you want to attach.

Attaching applications to your messages

You can create a new email with a Palm OS application attached (subject to copyright restrictions).

1. Press Applications Launcher  
2. Press Menu  
3. From the App menu, choose Send.
4. Choose the application you want to send. If the application has a lock icon next to it, it is protected and can't be attached.
5. Complete the message and send.
Sending and receiving messages
By default, your Treo will automatically send and receive messages (see page 79 for more details). You can manually send and receive messages on-demand as described below.
1. Make sure Wireless Mode is turned on (see page 14).
2. From any mailbox, choose Send and Receive.
3. From the Inbox, choose the message you want to view.
4. When viewing the message text, press Option and Left or Right to view the previous or next message.
5. Choose Done to return to the Inbox.

Receiving and viewing messages

Viewing attachments
There are a number of attachment types you can open with the built-in software on your Treo (e.g. ringtones, pictures). You can open other types of attachments by installing third-party applications. In Message view, attachments appear with the paperclip icon if they are unsupported on Treo. If attachments are supported on Treo, they appear with the icon for the associated program (e.g. the camera icon for pictures).
1. From any folder, open the message with the attachment you want to view.
2. Choose the attachment icon.
3. Follow the prompts from the viewing application.

Managing your messages
The status icons that appear next to each message in your Inbox indicate the following:
- You have not read the message
- You have read the message
- The message includes an attachment

You can rearrange the Mail list to make it easier to find and view messages.
- From the Mail list view, press Menu, then from the Options menu, choose one of the following: Sort by Date (/Z), Sort by Name (/Y), Sort by Subject (/J).
- To quickly switch between folders in list view, choose the folder pick list in the upper-right corner, then select the desired folder.

Replying to or forwarding messages
When you respond to messages, you can choose whether to include the original text (see page 80).
1. From the Inbox, Filed, or Deleted folder, open the message to which you want to respond.
2. From the Message view, choose Respond to reply. To reply to all or forward, choose the appropriate button.
3. Enter your reply.
4. Choose Send to finish.
Deleting selected messages from the Inbox
When you delete a message from the Inbox, it moves to the Deleted folder which stores the 200 most recently deleted messages. If you delete more than 200 messages, the oldest messages are automatically removed from the phone.
1. Highlight the message you want to delete. To highlight a group of messages, press Shift and Up or Down.
2. Press Backspace.
3. If a confirmation dialog appears, choose OK to confirm deletion.

Deleting messages by the date
You can quickly delete a group of messages by selecting a range of dates.
1. Press Menu.
2. From the Message menu, choose Purge (/K).
3. Choose a date range for the messages you want to delete.
4. Choose OK.
5. If a confirmation dialog appears, choose OK to confirm deletion.

Switching accounts
To switch between different email accounts, press Menu, then from the View menu, choose an account.

Customizing your Mail settings
If you have multiple email accounts, you can customize the Mail settings for each individual account on your Treo. Remember, the preferences you set will only apply to the email account you are currently viewing.
1. Press Menu.
2. From the Options menu, choose Preferences.
3. Set any of the following Delivery preferences:
   - Get mail: Sets the interval for mail delivery. If you select an automatic delivery option, you can also select the hours during which you want automatic delivery.
   - For each message get: Sets the maximum size for incoming messages. 1K of information is about 4 screens of text on your Treo.
   - Only get mail from last ## days: Specifies the timeframe for retrieving earlier messages.
   - Auto-deliver even when roaming: Specifies whether you can continue automatically retrieving your email when you are not in your mobile plan’s home area (which may incur additional charges on your account). This option applies only if you selected an automatic delivery option.
4. Choose the Delete tab and set any of the following preferences:
   • **Confirm message deletion**: Asks if you’re sure you want to delete a message before erasing it.
   • **Return to list view after deleting a message**: Shows the Mail list view after you delete a message, if checked, or shows the next message in the list, if unchecked.

5. Choose the Message tab and set any of the following preferences:
   • **Include original text when replying**: Appends the full text of the original message when you reply to a message.
   • **Include attachments when forwarding**: Sends attachments as well as the original message when forwarding, even if you cannot open an attachment on Treo.
   • **Always show Bcc**: Displays the Bcc field when creating messages and allows you to pre-fill this field with a default address (useful for creating a backup copy of email that is sent to your email server).
   • **Signature**: Controls what messages have your signature automatically appended to them and lets you define a custom signature.

6. Choose OK.
Displaying your calendar

- Press Calendar repeatedly to cycle through the various active views.
- Use the 5-way navigation control to move to another day, week, or month (depending on the current view).
- Choose Go or press Menu. From the Options menu, choose Go to Day (V/O), then choose a date from the calendar.

Creating an event
1. Press Calendar until you are in Day view.
2. Press Left and Right to select the desired day.
3. Using the keyboard, type a starting time for the event. For example, type 53 for 5:30 (Remember to press Option before typing numbers).
4. Press Down and type the ending time for the event.
5. Choose OK.
6. Type a description for the event.

Adding an alarm reminder to an event
1. In Calendar, highlight the event.
2. Choose Details.
3. Check the Alarm box and choose the number of minutes, hours, or days before the event you would like to receive the alarm.
4. Choose OK.

Creating an untimed event
An untimed event, such as a birthday or anniversary, does not occur at a particular time.
1. Press Calendar until you are in Day view.
2. Press Left and Right to go to the date of the event.
3. Make sure nothing is highlighted.
4. Type a description for the event.

Editing or deleting an event
1. Highlight the event you want to reschedule.
2. Choose Details.
3. Change the date and time as needed, or choose Delete.
4. Choose OK.

The silent alarm for untimed events is defined by minutes, days, or hours before midnight of the date of the event.

When an alert occurs, the Reminder screen displays all your Treo’s pending alerts. Tap an item’s description to jump to that item, or check the box to clear that item.
Scheduling a repeating event
1. Create an event, then highlight it.
2. Choose Details.
3. Choose the Repeat box, then choose a repeat interval.
4. For weekly events, choose the day(s) the event repeats; for monthly events, choose Day or Date to indicate the repeating method.
5. If the event has an ending date, choose the End on pick list, then select Choose Date, and select the ending date.
6. Choose OK.

Customizing general preferences for your calendar
1. Press Menu.
2. From the Options menu, choose Preferences (/R).
3. Set any of the following preferences:
   - **Start Time and End Time:** The beginning and end of the day shown on Calendar screens.
   - **Event Duration:** The default duration of a new event.
   - **Week Start:** The day on which the calendar week starts.
   - **Initial View:** The view that appears when you launch Calendar.

• **Button Views:** The views that appear when you press Calendar repeatedly. By default, you see Day and Month Views, but you can also see other views.

- **Display Options:** Your choices for different Calendar view options:
  - **Show Time Bars:** shows the duration of an event and illustrates conflicts.
  - **Compress Day View:** When off, all time slots display. When on, start and end times display for each event, but blank time slots disappear to minimize scrolling.
  - **Show PM Label:** Displays a p after PM times.
  - **Show End Times:** Displays all time bars and time slots for end times of an event.
  - **Auto-scroll Time:** Displays events based on the time of day when there is more than one screen of information. The arrows at the bottom-right corner indicate more information.
  - **Float Advance at Midnight:** Advances floating events to the next day at midnight of the current day.
  - **Show Completed Floating Events:** Displays completed floating events.

4. Choose OK to close the Display options dialog.
5. Choose OK.

To enter a birthday or anniversary, create an untimed event. Then, from the Details screen, choose Year as the repeat interval.
Customizing To Do List preferences for your calendar
You can display To Do List items in your calendar to keep on top of your tasks.
1. Press Calendar until you are in Day view.
2. Press Menu.
3. From the Options menu, choose To Do Preferences.
4. Set any of the following preferences:

To Do Preferences

- **Show Categories:** Determines which To Do List categories appear.
- **Priorities Displayed:** Limits the To Do List to certain priorities.
- **Show Priority:** Displays the priority assigned to an item.
- **Show Completed Items:** Displays checked off items.
- **Show Undated Items:** Displays items that do not have a Due Date assigned.
- **Show Dated Items:** Displays To Do List items that have a Due Date assigned.
5. Choose OK.

To save memory, you can purge all completed To Do List items. From the Record menu, choose Purge. Choose OK to finish.
You can set To Do List to record the date that you completed the To Do item, and you can choose to show or hide completed items. Completed items remain in the memory of your phone until you purge them.
You can display To Do List items in your calendar. See page 86 for information on customizing To Do List preferences for your calendar.

To Do List
You can use To Do List as a reminder of tasks you need to complete and to keep a record of complete tasks.

Adding a To Do item
1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the To Do List icon.
4. Choose New to create a new To Do item
5. Type the text of the To Do item. The text can be longer than one line.
6. Press Down to deselect the To Do item.

Setting item priority, due date, and other details
The Details dialog enables you to assign a priority level, due date, category, privacy flag, and note to each item.
1. Highlight the item to which you want to assign details.
2. Choose Details.

![To Do List example]

1. [To Do List]
2. [To Do List]
3. [To Do List]
4. [To Do List]
5. [To Do List]
3. Set any of the following:
   - Priority: Choose the Priority number for this item (1 is most important). Later you can arrange your To Do List based on the importance of each item.
   - Category: Assign the item to a specific category.
   - Due Date: Choose the Due Date pick list, then select a due date for the item.
   - Private: Check this box to mark this item private.
   - Note: Enter additional text you want to associate with the item.

4. Choose OK.

Checking off a To Do item
1. Choose the item you want to check off.
2. Hold Option ( ) and press Return ( ).

Deleting a To Do item
1. Highlight the item you want to delete.
2. Press Menu ( ).
3. From the Record menu, choose Delete Item (/D).
4. Choose OK.

Customizing To Do List
The To Do Preferences screen enables you to control the appearance of the To Do list screen.

1. In the To Do list screen, choose Show.
2. Set any of the following preferences:
   - Sort by: Indicates the order in which your To Do items appear in the list.
   - Show Completed Items: Displays items you’ve checked off.
   - Show Only Due Items: Hides items that are not yet due.
   - Record Complete Date: Replaces due date with the completion date when you complete (check) the item.
   - Show Due Dates: Displays item due dates, and inserts an exclamation mark next to overdue items.
   - Show Priorities: Displays the priority setting for each item.
   - Show Categories: Displays the category for each item.

3. Choose OK.
Memo Pad

Memos are a great way to store notes on your Treo.

Creating a memo
1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Memo Pad icon.
4. Enter the text you want to appear in the memo.
5. Choose Done.

Deleting a memo
1. Choose the memo you want to delete.
2. Press Menu .
3. From the Record menu, choose Delete Item (/D).
4. Choose OK.

CityTime

The CityTime world clock displays the day and time in your home city and in four other cities around the globe. Whether you're travelling or at home, it's easy to keep track of the best time to reach your business associates, friends, and family in far away places.

Setting your Home City
The Home City serves as a point of reference for your other city selections. The Home City time reflects the current system time (unless you have changed locations, see page 92). The information displayed for all the other cities is based on the day and time in your Home City.
1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the CityTime icon.
4. Press Menu .
5. From the Options menu, choose Select Home City (/H).
6. Choose the Home City pick list, then select the city closest to your location (in the same time zone).
7. Choose OK.
Selecting remote cities
In addition to your Home City, you can display the day and time for four other cities anywhere around the globe. These other cities are called remote cities.
1. Use the stylus to tap a pick list in the lower part of the CityTime screen, then select the city closest to the city you want to display.
2. Choose the remaining pick lists, then select the other three cities you want to display.

Adding cities
If the city you want to display is not in the predefined list, you can add it.
1. Press Menu .
2. From the Options menu, choose Edit Cities (/E).
3. Choose New.
4. Enter the city name and other information.
5. Choose OK.

Changing locations
If you travel, you can easily coordinate the system time on your Treo with the local time.
1. Press Menu .
2. From the Utilities menu, choose Change Location (/L).
3. Choose the To pick list, then select your new location.
4. Choose OK.

CityTime does not automatically update the system time for Daylight Savings Time.
Run your stylus over the map to see the time in other cities.
The shadow over the map represents nighttime moving across the globe.

Calculator
Calculator includes a basic calculator, plus an advanced calculator with scientific, financial and conversion functions.

Switching between Basic and Advanced Calculator modes
1. Press Menu .
2. From the Options menu, choose Toggle Mode (/M).

Selecting functions in Advanced Calculator mode
1. Switch to Advanced Calculator mode (see above).
2. Choose the pick list near the upper-left part of the screen, then select the Advanced Calculator function you would like to use:
   • Math: Advanced mathematical functions such as exponents, roots and logarithms.
   • Trig: Trigonometric functions such as sine, cosine, tangent and variants.
   • Finance: Financial calculator functions such as APR and amortization.
   • Logic: Hexadecimal characters in keypad, plus logic functions such as and, not, or and xor. In place of Float/Degrees (see below), this view includes options for class (bin, oct, SDec, UDec, hex) and bits (8, 16, 32).
Looking up contacts and other information

With the built-in search features on your Treo, you can find information quickly:

- **Name Lookup**: Enables you to dial your Contacts by name. It locates people's phone numbers when you're in the Contacts list.
- **Find**: Searches through the text in all the applications on your Treo.

**Name Lookup**

You can access Name Lookup directly from the Contacts list. This feature helps you locate Contacts quickly by entering just a few letters of a Contact's name.

1. Press Phone .
2. Use the 5-way navigation control to access the Contacts list.
3. From the Contacts list, enter the first few letters of the Contact you want to find. You can enter:
   - First name (JOH for John) or
   - Last name (SMI for Smith) or
   - First name initial and last name (JSM for John Smith)

4. Choose the pick list near the upper-right of the screen, then select whether you want to display numbers in degrees, radians or grads.

- **Statistics**: Statistical functions such as sum, factorial and random number generator.
- **Weight/Temp**: Weight and temperature conversions for metric and English values.
- **Length**: Length conversions for metric and English values.
- **Area**: Area conversions for metric, traditional and English values.
- **Volume**: Volume conversions for metric and English values.

3. Choose the pick list near the upper-middle of the screen, then select how to display decimal values:
   - **Float (Floating point)**: Position of decimal point varies according to calculation results.
   - **Fixed(x) (Fixed point)**: Enter an integer for the number of decimal places to display, then select Fixed(x) to round calculations to that decimal place.
   - **Sci(x) (Scientific notation)**: Enter an integer for the number of decimal places to display, then select Sci(x) to round calculations to that decimal place using scientific notation.
   - **Eng(x) (Engineering notation)**: Enter an integer for the number of decimal places to display, then select Eng(x) to round calculations to that decimal place using engineering notation.

4. Choose the pick list near the upper-right of the screen, then select whether you want to display numbers in degrees, radians or grads.

- **Choose Sto** to store a number in one of ten memory slots. Choose Rcl to recall a stored number.
- **Choose Con** to access a list of mathematical constants such as Avogadro’s number or the speed of light.
Your Treo is equipped with an IR (infrared) port that lets you beam information to another Palm Powered device with an IR port. The IR port is located on the top of your Treo, between the Wireless Mode button and the ringer switch, behind the small dark shield.

### Beaming a record
1. Choose the record or category you want to beam.
2. Press Menu.
3. From the Record menu, choose one of the following:
   - Beam (/B): Sends an individual record.
   - Beam Category (/Y): Sends all records in the current category.
4. When the Beam Status dialog appears, point the IR port on your Treo directly at the IR port of the receiving device.
5. Wait for the Beam Status dialog to indicate that the transfer is complete before you continue using your Treo.

### Beaming information

For example, entering SM displays Smilla Anderson, John Smith, and Sally Martin as shown above. Entering JSM finds only John Smith.

4. Do one of the following:
   - Highlight the contact name, then press Center to view the contents of the record.
   - Highlight any phone number, then press Center to dial.

### Using Find

The Find feature locates any text in the built-in applications and databases, and in some third-party applications. The Find feature performs an exact search on a character string, including characters that are parts of words.

1. Press Option then Shift to open the Find dialog.
2. Enter the text you want to find.
3. Choose OK to start the search.
4. In the search results, choose the text you want to review, or choose Find More to search additional applications.

#### Find

<table>
<thead>
<tr>
<th>Matches for “birthday”</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: Birthday</td>
</tr>
<tr>
<td>Company Birthday</td>
</tr>
<tr>
<td>Date: Birthday</td>
</tr>
<tr>
<td>Name: Work Birthday</td>
</tr>
<tr>
<td>Date: Work Birthday</td>
</tr>
<tr>
<td>Name: Home Birthday</td>
</tr>
<tr>
<td>Date: Home Birthday</td>
</tr>
<tr>
<td>Name: Friends Birthday</td>
</tr>
<tr>
<td>Date: Friends Birthday</td>
</tr>
<tr>
<td>Name: Birthday</td>
</tr>
</tbody>
</table>

You can store a beamed application on your phone, or send it to an expansion card inserted in the expansion slot.

Beam your business card in two key presses: in any Phone view, press Menu, then press M.
Beaming an application

Not all applications can be beamed. A lock icon 🗝 appears on the Beam screen next to applications that cannot be beamed.

1. Press Applications Launcher ☀.
2. Press Menu ☢.
3. From the App menu, choose Beam (/B).
4. Choose the Beam From pick list, then select whether the application you want to beam is located on your Treo or an expansion card.
5. Choose the application you want to transfer.
6. Choose Beam.
7. When the Beam Status dialog appears, point the IR port on your Treo directly at the IR port of the receiving device.
8. Wait for the Beam Status dialog to indicate that the transfer is complete before you continue using your Treo.

Receiving beamed information

1. Turn on your screen.
2. Point the IR port on your Treo directly at the IR port of the transmitting device to open the Beam Status dialog.
3. When the Beam dialog appears, choose a category for the entry.
4. Press Up ⬆️ to receive the beam or press Down ⬇️ to refuse it.

For best results, the path between the two devices must be clear of obstacles, and both devices kept stationary. If you have difficulty beaming, shorten the distance and avoid bright sunlight.

If you do not choose a category upon receiving a beamed item, the item is placed in the Unfiled category.

If you can’t receive beamed information, try a soft reset (see page 131).
Installing applications

Your Treo comes with several applications built-in and ready to use. You can also install third-party Palm OS applications, such as business software, games, and more. To learn more, go to www.palmOne.com/software.

When you download an application to your computer, it is probably in a compressed format such as a.zip or .sit file. If the file is compressed, you need to use a decompression utility on your computer, before you install applications on your Treo.

These instructions tell you how to install basic .prc (Palm OS application) and .pdb (Palm OS database) files onto your Treo. Some Palm OS software uses an installer or wizard to guide you through the process. Consult the documentation that came with the software for details.

Installing applications from the Internet

You can install Palm OS applications directly from the Internet, using the Blazer web browser. When you download an application, it automatically installs on your Treo. Remember: Palm OS applications have .prc or .pdb at the end of their file names.

1. Launch the Blazer web browser (see page 53).
2. Go to the page that contains the link to the application you want to download.
3. Press Left or Right to highlight the link to the application you want to download.
4. Press Center to initiate the download process.

Installing applications from a Windows computer

1. Double-click the .prc or .pdb file you want to install on your Treo.
2. A dialog may appear with a User drop-down list. Select your User Name from the list.
3. The Install Tool window appears. If you would like to install additional files, simply drag and drop them into the space in this window.
4. If you want to install an application to an expansion card, click Change Destination. Click the arrows to move the application to the expansion card pane, then click OK.
5. Click Done.
6. Perform a HotSync operation to install the application(s) on your Treo.
Removing applications

If you decide that you no longer need an application, or want to free up memory on your Treo, you can remove applications from your Treo or an expansion card (for more on expansion cards, see pages 105-108). You can remove only applications, patches, and extensions that you install; you cannot remove the built-in applications that reside in the ROM portion of your Treo.

1. Press Applications Launcher.
2. Press Menu.
3. From the Options menu, choose Delete (/D).
4. If you want to remove an application from an expansion card, insert the card into your Treo.
5. Choose the Delete From pick list, then select the location of the application you want to remove.
6. Choose the application that you want to remove.
7. Choose Delete to finish.
8. Perform a HotSync operation to remove the application from the Backup folder on your computer.

If the application re-appears on your device, you may need to manually delete it from your computer. Locate your Backup folder on your computer (Windows: C:\Program Files\palmOne\user name; Macintosh: Mac HD\Applications\palmOne\Users\user name). If you find a .prc or .pdb file for the application you just removed, delete the file from the Backup folder.

Installing applications from a Macintosh computer

1. On your Macintosh, launch Palm Desktop.
2. From the HotSync menu, choose Install Handheld Files.
3. Select the User Name that corresponds to your Treo phone from the User drop-down menu.
4. Click Add To List.
5. Locate the .prc or .pdb file you want to install on your Treo. Highlight it and click Add File.
6. Perform a HotSync operation to install the application(s) on your Treo.

Getting help with third-party applications

If you encounter a problem with a third-party application (such as an error message), contact the application’s author or vendor. For general troubleshooting of third-party applications, see page 145.

Some applications are factory-installed in your phone and cannot be deleted. These are listed with a lock icon next to them.

If you upgraded from a previous version of Palm Desktop software, your backup folder may be located in the Palm folder. Applications deleted from your phone are kept on your computer, in the Archive folder of your user folder.
Using Application Info

The Info screens display basic statistics about the applications on your Treo.
1. Press Applications Launcher.
2. Press Menu.
3. From the App menu, choose Info.
4. At the bottom of the screen, choose the type of information you want to view:
   - Version: The version numbers of applications on your Treo.
   - Size: The size (in kilobytes) of applications and data on your Treo.
   - Records: The number of records in different applications on your Treo.
5. Choose Done.

![Info Screen]

Using expansion cards

The expansion slot on your Treo enables you to add Secure Digital (SD) cards and MultiMedia Cards (MMC) to extend the storage capacity of your Treo. For example, SD or MMC expansion cards can store:
- Pictures
- MP3 audio files
- Games
- eBooks
- Applications
- Databases
- ... and more

Although expansion cards are sold separately, your Treo includes a mock, non-functional card inside the expansion slot. When you do not have a functioning card inside the expansion slot, reinsert the mock card to protect the slot opening.

Inserting and removing expansion cards

1. Press down and release the mock card.
2. After you feel the expansion slot eject the mock card, remove the card from the expansion slot.

![Expansion Card]

SD cards are faster than MMC cards for reading and writing data.

When not using the expansion card, reinsert the mock card to keep the expansion slot clean.

Warranty does not cover damage by Secure Digital (SD) cards which do not meet SD Memory Card Specifications. SD cards which do not meet SD Memory Card Specifications may damage Treo 600.
Using expansion cards

Copying applications to an expansion card
You can copy applications between your Treo and your expansion card.
1. Press Applications Launcher.
2. Press Menu.
3. From the App menu, choose Copy (/C).
4. Choose the Copy To pick list, then select the destination: card name, or Phone.
5. Choose the From pick list, then select the location of the application you want to copy: card name, or Phone.
6. Highlight the application you want to copy.
7. Choose Copy to finish.

Viewing expansion card information
The Card Info application displays general information about the expansion card that is currently in the expansion slot
1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Card Info icon.
Renaming an expansion card
If you change the contents of an expansion card, you may at some point want to rename the card to better match its contents.
1. Insert the expansion card into the expansion slot. The Applications Launcher automatically appears.
2. Choose the Card Info icon.
3. Press Menu (∫).
5. Type a new name for the card.
6. Choose OK.

Formatting an expansion card
Formatting an expansion card is similar to formatting a disk on a computer. When you format an expansion card, you erase all the data stored on the card.
1. Insert the expansion card into the expansion slot. The Applications Launcher automatically appears.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Card Info icon.
4. Press Menu (∫).
5. From the Card menu, choose Format Card (/F).
6. Type a new name for the card.
7. Choose OK.
Phone settings

Selecting ringtones and messaging alert tones
You can set different tones and volumes for incoming phone calls, Calendar alarms, and Mail, MMS, and Messaging alerts.

1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Sound.
5. Choose the Application pick list, then select Phone, Mail, Calendar, MMS, or Messaging.
6. Choose the Volume box.
7. Choose each pick list, then select an alert volume.
8. Choose the Tones box.
9. Depending on the application, select alert tones from the pick lists that appear:
   • Phone
     • Known Caller Tone: An incoming call from someone in your Contacts or Favorites.
     • Unknown Caller Tone: An incoming call from someone identified by Caller ID who is not in your Contacts or Favorites.
     • Roaming Tone: A special tone for incoming calls when you’re outside your home mobile network.
     • Voicemail Tone: A new voicemail.
     • Service Tone: A warning of a service change, such as moving into and out of a mobile network coverage area.
   • Mail
     • Message Tone: A message arrives with automatic delivery
   • Calendar
     • Alarm Sound: The tone played the first time your alarm goes off
     • Reminder Sound: The tone played if an alarm is not acknowledged and the alarm repeats itself
     • Play Sound: The number of times an alert tone will play during the alarm sequence
     • Repeat Alarm: The number of times the alarm repeats itself if not acknowledged
     • Every: The interval between alarm repeats if not acknowledged
     • Alarm Preset: A default for the number of minutes, hours, or days before the event that the alarm goes off
   • MMS
     • Message Tone: A new MMS message arrives
   • Messaging
     • Message Tone: A new text message arrives

Adjusting call volume
While a call is in progress, or while using the personal speakerphone, press the volume buttons on the side of your Treo to adjust call volume.
Assigning a caller ID picture and ringtone

1. Press Phone.
2. Press Up to access your Favorites buttons.
3. Highlight the Favorites button you want to give a picture caller ID.
4. Press Menu.
5. From the Edit menu, choose Edit Favorites Button (E).

7. Choose Select Image.
8. Choose the picture you want to assign to the selected Favorites button.
9. Choose Select.
10. From the ringtone pick list, choose a caller ID ringtone.
11. Choose OK.

Choosing Wallpaper for the Phone screen

If you have images stored on your Treo, you can select different wallpaper for the Main view in the Phone application.

1. Press Phone.
2. Press Menu.
3. From the Options menu, choose Display Preferences.
4. Choose the pick list at the top of the screen, then select Show Wallpaper.
5. Choose a Wallpaper image for your Phone screen.
6. Choose OK.
Display and appearance

Turning on the keyboard backlight
1. Press Option then . The backlight illuminates the keys, and the screen dims slightly.
2. The backlight will turn off if the keyboard is not in use.

Adjusting the contrast and brightness
Depending on the lighting conditions in which you’re using your Treo, you may need to adjust the screen contrast and brightness.
1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Display.
5. Choose the slider, and use Left and Right to adjust brightness.
6. Choose the slider, and use Left and Right to adjust contrast.

Changing the screen font
You can change the screen font in Calendar, Contacts, Memo Pad, Messaging, and To Do List.
1. Launch the application in which you want to change the font.
2. Press Menu .
3. From the Options menu, choose Font (/F).
4. Choose a font style:
   - Small font
   - Small bold font
   - Large font
   - Large bold font
5. Choose OK.

Aligning the touchscreen
Occasionally, your Treo touchscreen may need to be readjusted. If this occurs, you may see the wrong feature being activated when you tap the screen. To fix the problem, you can recalibrate the touchscreen any time.
1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Touchscreen.
5. Follow the onscreen instructions.

Changing the system color scheme
1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select General.
5. Choose the Colors pick list, then select a color scheme.
Applications Launcher settings

Arranging applications by category
You can assign an application to a category and then display a specific category of applications in the Applications Launcher.
1. Press Applications Launcher.
2. Press Menu.
3. From the App menu, choose Category (/Y).
4. Choose the pick list next to each application, then select a category.
5. Choose Done.

Displaying applications by category
Do one of the following:
- Press Applications Launcher repeatedly to cycle through the categories.
- Choose the pick list in the upper-right corner, then select a category.

Button settings

Buttons Preferences
Buttons Preferences let you choose which applications are associated with the buttons on your Treo.
1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Buttons.
5. Choose the pick list next to the button or key combination you want to re-assign, then select an application.

Setting default applications
Sometimes, one application looks for another application to handle data (for example, a mail application might launch a browser when you choose a link in an email message).
1. Press Applications Launcher.
2. Choose the pick list in the upper right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Default Apps.
5. Choose each pick list, then select the application you want to associate with that function.
Date and time settings

Setting the date and time

Date & Time Preferences enable you to set the time, date, time zone, and daylight savings setting for your Treo.

1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Date & Time.
5. Choose the Set Date box. Highlight the current year, month, and date, then press Center to set the date.
6. Choose the Set Time box. Using the stylus, tap the up and down arrows to select the current time, then choose OK to set the time.
7. Choose the Set Time Zone box. Choose the time zone for your location, then choose OK to set the time zone.
8. Choose the Daylight Saving pick list, then select On or Off.

Setting date and time formats

Formats Preferences enable you to choose number conventions based on geographic regions. For example, in the United Kingdom, time is expressed using a 24-hour clock. In the United States, time is expressed using a 12-hour clock with an AM or PM suffix. All the built-in applications on your Treo use the Format Preferences settings.

1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Formats.
5. Set any of the following preferences:
   - **Preset to:** The standard number conventions for your country. When you select a country, the other Formats Preferences are automatically set to that country's conventions. You can also edit each option individually.
   - **Time:** The time format. Select HH:MM to display a 24-hour clock.
   - **Date:** The date format.
   - **Week starts:** The first day of the week (usually Sunday or Monday).
   - **Numbers:** The format for numbers with decimal points and commas.
Locking your phone and data

Your Treo includes several features that help you protect your phone from inadvertent use and keep your data private. The built-in security software enables you to use your Treo for emergency calls even if the handset is locked.

- **Keyguard:** Manually disables all buttons and the touchscreen to prevent accidental presses in your briefcase or pocket.
- **Auto-Keyguard and touchscreen lockout:** Automatically enables Keyguard after a period of inactivity, and lets you disable the touchscreen during an active call or call alert.
- **Phone Lock:** Requires a password to make and receive calls with your SIM card.
- **System password lock:** Requires a password to see any data on your Treo.
- **Private records:** Masks or hides items marked as private, and requires a password to view them.

**Keyguard**

Your Treo includes a feature that locks the keyboard, so that you don’t accidentally press buttons or activate screen items while the phone is in a pocket or bag.

1. With the Treo screen on, press Option and the Screen button to enable Keyguard.
2. To disable Keyguard, press Center.

General Preferences

General Preferences enable you to set the auto-shutoff interval, the beam receive feature, sounds, and screen colors for your Treo.

1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select General.

5. Set any of the following preferences:

- **Auto-off After:** The time that elapses before your screen turns off automatically.
- **System Sound:** The volume for system beeps and alerts.
- **Game Sound:** The volume for game sounds.
- **Beam Receive:** The setting for whether you want your Treo to receive beamed information.
- **Colors:** The set of predefined colors for the system display.

The system and game volume settings apply when the ringer switch is set to the on position.

When you receive or make a call, the touchscreen on the Active call screen may be automatically disabled to prevent accidental termination of a call. You must use the 5-way navigation control to access the buttons on the Active call screen. Check the Keyguard settings in Preferences.
Auto-Keyguard and touchscreen lockout

Auto-Keyguard lets you automatically lock the keyboard after a period of inactivity.
1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Keyguard.
5. Set any of the following preferences:
   - Auto-Keyguard: The period of inactivity that passes before the keyboard automatically locks.
   - Disable touchscreen when: The conditions under which the touchscreen disables.

Phone Lock

You can lock your SIM card to prevent unauthorized use of your mobile account. When your SIM card is locked, you must enter the correct PIN code to unlock it, even if you move it to a different phone.
1. Press Phone .
2. Press Menu .
3. From the Options menu, choose Phone Lock (/L).
4. Check the Lock SIM box.
5. When prompted, enter the current PIN and choose OK. Unless you changed your PIN code, enter the default PIN code, provided with your mobile service provider's account materials.
6. If you want to change the PIN, choose Change PIN, enter a new PIN, then choose OK to accept it. Repeat this step to verify the new PIN.
7. Turn Wireless Mode off to activate the phone lock feature.
8. To turn Wireless Mode on again, press and hold the Wireless Mode button , enter your PIN, then choose OK to unlock your phone.

Your SIM card locks again when you turn off Wireless Mode and then turn it back on. To permanently unlock your SIM card:
1. Press Menu .
2. From the Options menu, choose Phone Lock (/L).
3. Uncheck the Lock SIM option.
4. When prompted, enter the current PIN and choose OK.

System password lock

To protect your personal information, you can lock the system so that you need to enter your password to access any of your data or use other features of your Treo.
1. Press Applications Launcher .
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Security icon.
4. Choose the Password box.
5. Assign a password and a password hint to your Treo.
6. Choose the Auto Lock Handheld box.
7. When prompted, enter your password.
8. Choose one of the following options:
   - Never: Prevents your Treo from locking automatically.
   - On power off: Locks your Treo when you turn off the screen, or when it shuts off with the auto-off feature.
   - At a preset time: Locks your Treo at a specific time of day.
   - After a preset delay: Locks your Treo after a period of inactivity.

Important: If you lock your system, you must enter the exact password to unlock it. If you forget the password, you need to perform a hard reset to resume using your phone. Performing a hard reset deletes all the records in your phone. However, you can restore all previously synchronized data at the next HotSync operation (see page 137).

To lock your system manually, choose Lock & Turn Off, and then choose Off & Lock.
Setting Owner Preferences
You can use Owner Preferences to record information that you want to associate with your Treo, such as your name, company name, and phone number. If you lock your keyboard, the Owner Preferences information appears on the screen that requests your password to unlock it, and you must also enter your password to change the Owner Preferences information.

1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Owner.
5. If you assigned a password with the Security application, choose Unlock, enter your password, then choose OK to continue.
6. Type the text that you want to appear in the Owner Preferences screen.

Private records
In most applications you can mark individual entries as private. All private entries remain visible and accessible until you select the Security setting to hide or mask them. When you hide entries, they do not appear anywhere in the application. When you mask entries, a visual placeholder appears where the entry would normally appear. If you define a password, you must enter it to display private entries. If you do not define a password, you (or anyone else) can reveal private entries without a password.

1. Display the entry that you want to mark private.
2. Choose Details.
3. Check the Private box.
4. Choose OK.

Hiding or masking all private records
1. Make sure the records you want to mask are marked private.
2. Press Applications Launcher.
3. Choose the pick list in the upper-right corner, then select All.
5. Choose the Current Privacy pick list, then select either Hide Records or Mask Records.

Viewing all private records
1. Make sure the records you want to mask are marked private.
2. Press Applications Launcher.
3. Choose the pick list in the upper-right corner, then select All.
5. Choose the Current Privacy pick list, then select Show Records.
6. If the Show Private Records dialog appears, enter your password, then choose OK.

As a security measure, masked Contacts records are temporarily hidden when you perform a search. So you will not see a placeholder for masked entries when viewing the results of a Lookup or Find request.
Viewing private entries in a specific application
1. Launch the application that contains the private entries you want to display.
2. Press Menu (Menu).
3. From the Options menu, choose Security (/H).
4. Choose the Current Privacy pick list, then select Show Records.
5. Choose OK.

Security and Palm Desktop (Windows)
Palm Desktop for Windows observes the security password for your Treo. If you forget your Treo password, you cannot view your data in Palm Desktop. You can change your password, but all records marked as Private will be deleted. You can restore these records at the next HotSync operation.
1. Press Applications Launcher (Applications).
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Security icon.
4. Choose the Password box.
5. Choose the Lost Password box.
6. Choose Yes.

If you want additional security for Palm Desktop files, you may wish to purchase a third-party solution.
Upgrading from another Palm Powered device

To transfer all compatible applications and data from your previous device to your new Treo:
1. Perform a HotSync operation with your old device and your old desktop software to back up your data one last time.
2. Install the Palm Desktop synchronization software from the CD that came with your Treo (see page 29). During the installation process, perform a HotSync operation with your new Treo. When prompted to choose a user name for your new Treo, be sure to select the existing user name for your old device.
3. Some third-party applications may be quarantined by the HotSync Manager because they are not compatible with the Palm OS 5.2 on your Treo. Do not manually install any quarantined files (see the documentation that came with the third-party applications for more information).
4. If you plan to continue using your old device, perform a hard reset (see page 132) to remove its associated user name. Each device you synchronize with your computer must have a unique name. The next time you synchronize with your old device, be sure to assign it a new user name.

After upgrading, there are a few things you need to know about your new Treo:
• Address Book: This application is now called Contacts. To launch Contacts, press Phone 7, then use the 5-way navigation control to choose Contacts.
• Date Book+: This application is now called Calendar. To access this application, press Calendar 6.
• Applications Launcher: Some previous Palm Powered devices called this the Home screen. To access this screen, press Applications Launcher.
• Find: Some previous Palm Powered devices launched this global search engine by tapping the magnifying glass icon in the Graffiti area. Now you can access it by pressing Option and Shift together.
• Menu commands: Users familiar with Graffiti's Menu launch command can now access system menus by pressing Menu (see page 22).
• Backlight: Treo includes a keyboard backlight that also dims the screen slightly for low light conditions. While your Treo screen is on, press Option then P to turn on the keyboard backlight.
• Center button: If you used a previous Treo phone, you might be accustomed to pressing Spacebar to activate commands or dial numbers. With this Treo phone, we recommend pressing Center instead.
• Screen button: The fourth button on the right is used to control the screen and is not an application button. However, you can remap this button to your favorite application if you wish (see page 117).
• Internet connection: This Treo was designed to work on GPRS wireless data networks. When you sign up for a GPRS wireless data account, these settings are automatically configured on your Treo. If you prefer to use an older, manual dial-up connection method, enter your Internet service provider's settings in Network Preferences.
• 5-way navigation compatibility: Some Palm OS 5 applications are optimized for 5-way navigation on devices other than Treo. Therefore you may notice inconsistencies with software that is not designed with Treo in mind.

Always use the same language for your Treo and your desktop software. Otherwise, you may lose data.

To access a menu shortcut, press Menu, then the letter for the shortcut.

Some third-party utilities allow you to backup your old device's data onto an SD or MMC card, and then transfer the data to your Treo. We do not recommend this method because any incompatible applications are also transferred to your Treo.
Trouble installing Palm Desktop?

The CD included with your Treo installs the software and drivers that let you synchronize with Palm Desktop software or Microsoft Outlook for Windows. If you want to synchronize with a different Personal Information Manager (PIM), you must install a third-party solution. Contact the PIM’s author or vendor to learn if software is available for your Treo.

1. Restart your computer.
2. Quit any active applications, including virus scanners and Internet security applications.
3. Make sure you’re installing the version of Palm Desktop that came on the CD with your Treo. Other versions of Palm Desktop may not work with this Treo.
4. Make sure your computer profile includes administrator rights to install software. In large organizations, these are usually granted by the system administrator.

Resetting your Treo

Soft reset

A soft reset is similar to restarting a computer. If your Treo is not responding or you have trouble synchronizing with your computer, a soft reset may help. Unless your battery is extremely low, a soft reset should not affect your data.

1. Unscrew the stylus tip to access the reset tool.
2. Use the reset tool to gently press the reset button on the back of your Treo.

System reset

A system reset, also called a safe or warm reset, tells your Treo to stop what it’s doing and start over again without loading any system extras. If your Treo loops or freezes during a soft reset, a system reset may help. Performing a system reset allows you to get out of an endless loop in order to uninstall a third-party application causing the looping. Unless your battery is extremely low, a system reset should not affect your data.

1. Unscrew the stylus tip to access the reset tool.
2. While holding Up ▲, use the reset tool to gently press the reset button on the back of your Treo.
3. When the Palm Powered logo appears, release Up ▲.
Screen

The screen appears blank
1. Look closely at the screen. If you can see a dim image, try adjusting the screen contrast and brightness (see page 114).
2. If that doesn’t work, perform a soft reset (see page 131).
3. If that doesn’t work, connect the Treo to the AC charger (see page 12) and perform a soft reset again.
4. If that doesn’t work, perform a hard reset (see page 132).

The screen doesn’t respond accurately to taps or activates wrong features
1. Press Applications Launcher.
2. Choose the pick list in the upper-right corner, then select All.
3. Choose the Prefs icon.
4. Choose the pick list in the upper-right corner, then select Display.
5. Choose Touchscreen.
6. Follow the onscreen instructions to recalibrate the touchscreen.

Hard reset
A hard reset erases all data and third-party software on your Treo. Never perform a hard reset without first trying a soft and system reset. You can restore previously synchronized data with the next HotSync operation.

A hard reset can tell you whether a problem stems from your Treo or an application installed on it. If you do not experience the problem after you perform a hard reset, the problem may be related to software you installed.

See page 145 for suggestions on diagnosing third-party software issues.
1. Unscrew the stylus tip to access the reset tool.
2. While holding the Wireless Mode button, use the reset tool to gently press the reset button on the back of your Treo.
3. When the Palm Powered logo appears, release the Wireless Mode button.
4. When the warning appears, press Up to confirm the hard reset.
5. If a language selection screen appears, select the same language you selected for your desktop software.
Network connection

I can't tell if data services are available
The following icons indicate data services:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📡</td>
<td>Wireless Mode is on and a GPRS network is within range.</td>
</tr>
<tr>
<td>⏫</td>
<td>Wireless Mode is on but you are not connected to any GPRS network.</td>
</tr>
<tr>
<td>📘</td>
<td>You are connected to a GPRS network and a data session is active (for example, when you are browsing the web). You can still receive calls.</td>
</tr>
<tr>
<td>📡📱</td>
<td>You are actively using a dial-up (CSD) connection.</td>
</tr>
</tbody>
</table>

Signal strength is weak
1. If standing, move about 10 feet in any direction.
2. In a building, move near a window. Open any metal blinds.
3. In a building, move outdoors or to a more open area.
4. Outdoors, move away from large buildings, trees, or electrical wires.
5. In a vehicle, move your Treo level with a window.

Treo won't connect to the mobile network
1. Try our suggestions above for weak signals.
2. Turn off Wireless Mode and turn it on again (see page 14).
3. Remove the SIM card and re-insert it (see page 13).
4. Perform a soft reset (see page 13).

Treo hangs up when I hold it to my ear
You may be accidentally pressing the onscreen Hang Up button with your cheek. Try holding the phone so your face doesn't press against the screen. If this is not convenient, you may want to disable the touchscreen during active calls (see page 122).

Treo makes or answers calls when it’s in a briefcase or pocket
Items in your briefcase or pocket may be pressing the onscreen Answer button, or otherwise activating screen items. If this happens, you may want to disable the touchscreen during incoming calls (see page 121).

Become familiar with low coverage areas where you live, commute, work, and play. Then, you will know when to expect signal strength issues.

Treo won't connect to the Internet
Your Treo supports GPRS. To connect to the Internet, you must subscribe to and activate GPRS data services with your mobile service provider.

• Press and hold the Wireless Mode button 📡 to turn off Wireless Mode. Then, press and hold the same button to turn it back on again.
• Perform a soft reset (see page 13).
• For additional suggestions, see www.palmOne.com/support.
Synchronization (HotSync)

Synchronization lets you back up your Treo data onto your computer. If you ever need to perform a hard reset or otherwise erase all your data on your Treo, you can perform a HotSync operation to restore the data. To make sure you always have an up-to-date backup of your data, synchronize frequently.

Before you attempt a HotSync operation, make sure you have installed the Palm Desktop and HotSync Manager software from the CD that came with your Treo.

Desktop does not respond to HotSync attempt

As you complete the following steps, perform a HotSync operation after each. If the synchronization is successful, you do not need to complete the remaining steps.

1. Verify that the HotSync cable is securely connected at all points (see page 28).
2. Make sure that the HotSync Manager is running:
   • Windows: Click the HotSync Manager icon in the lower-right corner and make sure Local USB is checked. If you don’t see the HotSync Manager icon, click Start, select Programs, select palmOne and then select HotSync Manager.
   • Macintosh: Find the Palm folder on your Mac hard drive. Double-click the HotSync Manager icon in the Palm folder. In the Connection Settings panel, set the Local Setup Port to palmOne USB.
3. Contact your mobile service provider to verify that your subscription plan includes high-speed data services and that these services have been correctly activated. Your mobile service provider should also be able to tell you if there are any outages in your location. Confirm your user name and password.
4. Confirm that high-speed data services are correctly configured on your Treo:
   1. Press Applications Launcher.
   2. Choose the pick list in the upper-right corner, then select All.
   3. Choose the Prefs icon.
   4. Choose the pick list in the upper-right corner, then select Network.
   5. If the Service field says Untitled, choose the Service pick list, then select the appropriate data service. Call your mobile service provider for more information about their data services.
   6. Choose Modify and enter the user name and password you received from your mobile service provider.
5. Choose OK.

I can’t send or receive text or multimedia messages

• Make sure the SIM card is inserted correctly (see page 13) and Wireless Mode is turned on (see page 14).
• Contact your mobile service provider to verify that your plan includes messaging services, that these services have been correctly activated, and that they are available at your location (your mobile service provider should be able to tell you if messaging services have been experiencing transmission delays).
• If possible, contact the recipient or sender of the message, and make sure the receiving device can handle the type of file that is being sent.
• If an SMS message arrives but does not display an alert, perform a soft reset (see page 131).
3. Verify with your computer hardware vendor that your operating system supports your internal USB Controller.
4. Perform a soft reset (see page 131).
5. If problems persist and you’re synchronizing through a USB hub, try connecting the HotSync cable to a different USB port, or directly to your computer’s built-in USB port.
6. Uninstall Palm Desktop.
7. Reboot your computer.
8. Reinstall Palm Desktop.

HotSync operation starts but stops without finishing

As you complete the following steps, perform a HotSync operation after each step. If the synchronization is successful, you do not need to complete the remaining steps.

1. If you upgraded from a previous Palm Powered device, there may be conflicts with files from your previous device. Locate your Backup folder (Windows: C:\Program Files\palmOne\user name; Macintosh: Mac HD\Applications\palmOne\Users\user name). Move the Backup folder to another location. Perform a HotSync operation, and then manually reinstall any third-party applications you want on your new phone, from the items in the old Backup folder you moved.
2. (Windows only) If the Windows New Hardware Wizard appears, the HotSync process may be timing out before the wizard completes its job. Follow all instructions in the New Hardware Wizard, and attempt another HotSync operation.
3. Uninstall Palm Desktop.
4. Reboot your computer.
5. Reinstall Palm Desktop.

HotSync operation finishes but data does not appear where it should

1. Make sure you’re synchronizing with the intended desktop Personal Information Manager (PIM). The CD that came with your Treo lets you synchronize with Palm Desktop or Microsoft Outlook for Windows. If you use a different PIM, you will need to install third-party software to synchronize. Consult the company that makes the PIM for more information.
2. If there are multiple Palm Powered devices synchronizing with your computer, make sure you are synchronizing with the correct user name. If data is not appearing in Palm Desktop, make sure the correct user name is selected in the toolbar of Palm Desktop.
3. Launch the HotSync Manager application on your computer, and make sure the necessary conduits are set to Synchronize the files.
4. Uninstall Palm Desktop.
5. Reboot your computer.
6. Reinstall Palm Desktop.
7. (Outlook only) With the included software, your Treo can synchronize with the root folders of Contacts, Calendar, Tasks, and Notes. If you want to synchronize with a global Exchange Address Book, you must copy the addresses to your local Contacts list in Outlook (right-click the addresses, and select Add to Personal Address Book).
8. (Outlook only) Outlook subfolders and public folders are not accessible with the included software. You may wish to use a third-party solution instead.
9. (Outlook only) If you’re trying to synchronize offline, be sure to set your Outlook Calendar, Contacts, Notes, and Tasks to be available offline.

The software that lets you synchronize with Microsoft Outlook is called PocketMirror, from Chapura, Inc. When you install the Treo software from the CD, PocketMirror will be activated if you choose the option to synchronize with Outlook.
Mail

I can't receive email

First, make sure you have Internet access: launch the Blazer web browser to see if you can view a web page you've successfully viewed before. If necessary, ensure that you are viewing the page directly from the Internet: press Menu , then from the Page menu, choose Refresh. The email account you use with the Mail application must be POP3-compatible, such as Earthlink.

1. In Mail, press Menu .
2. From the View menu, choose Edit Accounts.
3. Highlight an account, then choose Edit.
4. Make sure your email address and password are correct.
5. Choose the Server tab.
6. Check the Incoming (POP3) Server and Outgoing (SMTP) Server settings for your email account. If you do not have this information, please contact your email service provider.
7. Choose OK to accept these settings.
8. Choose Done.

Other things to consider when trying to retrieve email:

- In Mail, press Menu , then from the Options menu, choose Connection Log. This log contains details and error messages from the last several send and receive sessions.
- Mail does not automatically retrieve your email when:
  - Your radio is off.
  - You are outside the automatic delivery time window. See page 79 for more information on customizing your mail settings.

I can't open or save an attachment

- You can only open attachments that are supported by the built-in software on your Treo, or by third-party applications that can open the attachment type. If you can't open an attachment on your Treo, the attachment appears with the paperclip icon .
- Large attachments may be truncated, which prevents you from saving them. Scroll to the bottom of the email message to see if this is the case. To retrieve the rest of the attachment, press Menu , then from the Message menu, choose Get Entire Message. This downloads the remainder of the attachment so that you can save it.

I can't send email

Your ability to send email depends on several factors. You may need to enter additional information into the Mail application. Also, some mobile service providers use Internet security requirements that may cause difficulties with your email service.

- Some email preferences may not work with your Treo or your mobile network's capabilities. To view these settings, press Menu , then from the View menu, choose Edit Accounts. Choose an account and press Right to choose Edit. Each setting is explained in detail in the Tips for that tab. Contact your email service provider to determine the correct settings for your email account.
- Auto-retrieve settings apply to only the mail account you are currently viewing. If you have two accounts, Treo auto-retrieves emails for only the current account. To change the current account, press Menu , then from the View menu, choose another account.

If you use web-based email (Hotmail, AOL) or corporate email (Microsoft Outlook, Lotus Notes), the Mail application that comes with Treo will not work. You must use a third-party solution.

Contact your email service provider if you are not sure whether your email account is POP3-compatible.

When retrieving messages, you may see a larger number of messages than you actually receive (e.g., you see Retrieving 1 of 10 messages and you only receive 3 messages). If this happens, check your Delivery Preferences. If the preferences are set to retrieve only recent emails, any older emails may appear in the total number, but are not delivered to your Treo.
First, obtain this information from your mobile service provider*:
- Does the Internet connection they provide support sending SMTP emails?
- Is there an alternate SMTP authenticated server used for email?
- Is SSL required for POP3 or SMTP email transactions?
- If you are using a circuit-switched data (CSD) connection, contact your Internet service provider for this information, instead of your mobile service provider.

Then, contact your email service provider for this information:
- Does this provider support the POP3 protocol? If they don’t, you won’t be able to use Mail for this email account.
- Does this provider allow email access from mobile phone networks?
- What is the User Name for your email account?
- What is the Outgoing (SMTP) server for your email account? Does it require authentication? Does it require SSL? Does it use the same User Name for POP3 and SMTP?

Then, follow these steps:
1. In Mail, press Menu (Menu) .
2. From the View menu, choose Edit Accounts.
3. Highlight the account you want to edit, then choose Edit.
4. Make sure your email address and password are correct.
5. Choose the Server tab. Tap the Information icon (Information) for a detailed explanation of Server settings.
6. Enter the correct Incoming (POP3) Server setting for your email account. Enter the SMTP server used by your mobile service provider for email.
7. Choose the Advanced tab. Tap the Information icon (Information) for a detailed explanation of Advanced settings.
8. Check or uncheck the boxes for SSL required for POP3 and SSL required for SMTP, according to the information you received.
9. If necessary, enter your User Name. Also enter your email password in the box.
10. Choose OK to accept these settings.
11. Choose Done.

I can’t access a page
First, make sure you have Internet access: launch Blazer and try to view a web page you’ve loaded before. Press Menu (Menu) , then from the Page menu, choose Refresh to get the latest version from the Internet. After confirming your Internet connection, try to view the page in question again, and press Menu (Menu) then from the Page menu, choose Refresh.

If you’re still having trouble, the page may contain elements that are not supported by Blazer. These include Flash, Shockwave, VBScript, WML script, and other plugins.

Some websites use a redirector to their true home page (for example, if you enter the address http://www.palmOne.com/support it may resolve to http://www.palmOne.com/us/support). If Blazer can’t follow the redirect, try using a desktop browser to see the landing page of the redirector, and enter that address in Blazer.

An image or map displays too small on the Treo screen
Blazer has two modes: Optimized and Wide Page. Optimized Mode re-sizes all images and page elements to fit in a single column on the Treo screen. Switch to Wide Page mode to see the full-size image (see page 54).

A secure site refuses to permit a transaction
Some websites don’t support certain browsers for transactions. Please contact the site’s webmaster to make sure the site allows transactions using Blazer.

Web
Camera

The Camera application takes pictures at Small picture size (160x120 pixels) and Large picture size (640x480 pixels, or .3 megapixel). Here are some tips for taking good pictures with the built-in camera:

- Clean the camera’s lens with a soft, lint-free cloth.
- Take pictures in bright lighting conditions. Low-light images may be grainy due to the sensitivity of the camera.
- Hold the camera as still as possible. You may want to support your picture-taking arm up against your body or a stationary object (such as a wall).
- Keep the subject of the pictures still. Exposure time is longer with lower light levels, so you may see a blur.
- For best results, verify that you have the brightest light source coming from behind you, lighting the subject’s face. Don’t take indoor pictures with the subject in front of a window or light.
- Make sure the subject is at least 18 inches away from the camera to ensure good focus.

Remember, when you synchronize, your Camera images are stored in the Treo Pictures folder on your hard drive (see page 62).

The Camera preview image looks strange

Some third-party applications overwrite the Treo’s color settings with their own 8-bit color settings. This can affect the Camera preview mode. Delete third-party applications one by one until the preview image improves.

When using the camera in low light, you may see blue specs on the screen. Once you capture the image, the quality improves, and many of the blue specs disappear.

Third-party applications

Sometimes, third-party applications can cause conflicts on your Treo. Third-party applications that modify wireless features may require extra troubleshooting.

If you recently installed an application and your Treo seems to be stuck, try the following:
1. Perform a soft reset (see page 131).
2. If the problem persists, perform a system reset (see page 131).
3. Delete the most recently installed application from your Treo (see page 103).
4. If the problem persists, perform another system reset.
5. Delete other third-party applications one at a time until you eliminate the problem.
6. If none of the steps above are possible, you may wish to perform a hard reset (see page 132). Then, locate your Backup folder on your computer (Windows: C:\Program Files\palmOne\user name; Macintosh: Mac HD\Applications\palmOne\Users\user name). If you find a .prc or .pdb file for any applications you just removed, delete the file(s) from the Backup folder. Then, perform a HotSync operation to restore your data and applications.

Remember, not all third-party applications were written with the Treo keyboard and 5-way navigation in mind. You may encounter strange behavior or errors in these applications if you use the keyboard and navigation control.

Getting more help

Contact the author or vendor of any third-party software if you require further assistance.
Making room on your Treo

If you store a large number of records, or install many third-party applications, the internal memory on your Treo may fill up. Here are some common ways to clear space on your Treo:

- **Mail**: Emails that have large attachments can quickly consume memory on your Treo. Delete emails with large attachments. If you have hundreds of messages with or without attachments, you may wish to delete older messages to make room (see page 78).
- **Camera**: Large size images take up a lot of memory. Move images to an expansion card or delete images from your Treo (see page 62).
- **MMS**: Multimedia content also can consume excessive memory. Move MMS content to an expansion card or delete large files from your Treo (see page 71).
- **Internet**: If you have set a large Blazer cache, you may wish to use Blazer's advanced Memory Management settings to clear all recent pages (see page 59).
- **Third-party applications**: You can delete infrequently used applications or move them to an expansion card (see page 103).

Also, remember that your Treo includes an expansion slot, and that you can store applications and data on expansion cards. However, you still need some free memory on the Treo itself to run applications from an expansion card.

Errors

Your Treo is designed to minimize interruptions, when a system error occurs. If Treo encounters a system error, it automatically resets itself and resumes functioning as normal. If possible, it even turns Wireless Mode back on if it was on before the error occurred.

Sometimes, you might want to know more about an error. Treo uses a special interface to show error messages in greater detail.

1. Press Phone .
2. Press Center, then choose Dial Pad.
3. Type # * 377, then press Center.
4. Review the screen with details about the conditions that lead up to the most recent automatic reset.
5. Choose OK.

Please note that third-party developers create their own error messages. If you do not understand an error message, please contact the developer of the application for help.
Voice quality

Is the other person hearing an echo?
• Try decreasing the Treo’s volume to avoid coupling or feedback on the other person’s end. This applies to both speakerphone and the built-in handset speaker.
• Position the Treo handset closer to your ear to prevent sound leaking back to the microphone. Keep your hand away from the microphone hole, which is on the back of your Treo near the bottom of the device.
• If you’re using Speakerphone mode with the device lying on a flat surface, try turning the Treo “face down” (screen facing the surface).

Are you hearing your own voice echo?
• Ask the other person to turn down their volume, or hold the phone closer to their ear.

Is your voice too quiet on the other end?
• Be sure to hold the bottom of the Treo, or the hands-free microphone, close to your mouth.
ALS (Alternate Line Service): A service that enables two phone numbers to coexist on one phone/SIM. The Treo phone supports ALS, but be sure to contact your mobile service provider for regional availability of this service.

Alt (alternative): A keyboard key. Type a letter on the keyboard, then press Alt to access variations such as international characters and symbols.

Applications Launcher: The view on your Treo from which you can launch all applications.

Auto-off interval: The time of inactivity that passes before the screen on your Treo turns off. Wireless Mode is unaffected by this setting.

Beam: The process of sending or receiving a data record or application using the infrared port on your Treo.

CSD (Circuit-Switched Data): A dial-up Internet connection. You pay for the connection time, not how much data you transfer. Contrast with GPRS.

GPRS (General Packet Radio Service): The next generation of mobile Internet connectivity that allows persistent data connections. You pay for the amount of data you transfer, not the connection time.

HotSync: The PalmSource technology that synchronizes your Treo and your computer with the simple press of a button.

HotSync Manager: The computer application that manages the synchronization with your Treo.

Infrared (IR): A way of transmitting data using light waves. The IR port on your Treo lets you transfer data between other IR devices within a short radius.

Install tool: The component of Palm Desktop software that enables you to install Palm OS applications and data on your Treo.

Lithium Ion (Li-Ion): The rechargeable battery technology used in Treo phones.

MMS (Multimedia Messaging System): An enhanced form of SMS messaging that lets you send pictures, animations, and ringtones almost instantly.

Option key: The keyboard button that lets you access the alternative feature that appears above the letter on each key.

Palm Desktop: A PIM application for computers that helps you manage your personal information and keep your personal data synchronized with your Treo.

Palm OS: The operating system of your Treo phone. A trademark of PalmSource, Palm OS is known for its simplicity of use and for the large number of applications that can be added to your Treo.

Phone: The application on your Treo that provides quick access to the most commonly used applications on your Treo.

PIM (Personal Information Management): A genre of software that includes applications such as Palm Desktop software, Microsoft Outlook, Lotus Notes, and ACT!. PIMs generally store contacts, schedules, to do items, and memos.

SMS (Short Messaging Service): The service that exchanges short text messages almost instantly between mobile phones. These messages can usually include up to 160 characters. Treo phones can send and receive SMS messages while you are on a voice call.

User name: The name associated with your Treo that distinguishes it from other Palm Powered devices. When you first synchronize your Treo, you are asked to give it a user name.

Wireless Mode: The feature inside your Treo that controls the radio which enables you connect to the mobile network for wireless communications.
RF Safety Exposure To Radio Frequency Energy (SAR) Radio transmitting devices radiate Radio Frequency (RF) energy during its operation. RF energy can be absorbed into the human body and potentially can cause adverse health effects if excessive levels are absorbed. The unit of measurement for human exposure to RF energy is “Specific Absorption Rate” (SAR).

The Federal Communications Commission (FCC), Industry Canada (IC) and other agencies of the world have established limits that incorporate a substantial safety margin designed to assure the safety of all persons using this equipment. In order to conform to these limits, the unit must be placed at a minimum distance from the RF antenna and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

1. Reselect the receiving antenna.
2. Increase the separation between the equipment and receiver.
3. Connect the equipment into an outlet or circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help and for additional suggestions.

FCC RF Safety Statement

In order to comply with FCC RF exposure regulations, the unit must be placed at a minimum distance from the RF antenna and used in accordance with the instructions.

1. A palmOne brand body-worn accessory that has been tested for compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF energy.
2. An accessory that contains NO metal (snaps, clips, etc) and provides an area of at least 5 cm from the body-worn accessory to which the receiver is connected.

Testing for exposure to radio frequency energy (SAR)

The Federal Communications Commission (FCC), Industry Canada (IC), and other agencies of the world have established limits that incorporate a substantial safety margin designed to assure the safety of all persons using this equipment.

In order to comply with the FCC's RF exposure guidelines, this device was tested with the following accessories:

- Body SAR: 0.562 W/kg
- Head SAR: 1.630 W/kg

Maximum Measured SAR Values (W/kg)

Band: 850 MHz 900 MHz 1800 MHz 1900 MHz

Head SAR: 1.49 1.07 1.53 1.05

Body SAR: 0.54 0.10 0.42 0.06

EMC: EN 301 489

GSM: EN 301 419 (Apr-2000)

EN 301 489 (Dec-1999) SAR: ANSI/IEEE C95.1 1992


Radiated Emissions: EN 55022

Immunity: EN 55024

Radiation Safety

RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of body-worn accessories:

1. A palmOne brand body-worn accessory that has been tested for compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF energy.

2. An accessory that contains NO metal (snaps, clips, etc) and provides an area of at least 5 cm from the body-worn accessory to which the receiver is connected.

3. Reselect the receiving antenna.
4. Increase the separation between the equipment and receiver.
5. Connect the equipment into an outlet or circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help and for additional suggestions.

FCC RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of body-worn accessories:

1. A palmOne brand body-worn accessory that has been tested for compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF energy.

2. An accessory that contains NO metal (snaps, clips, etc) and provides an area of at least 5 cm from the body-worn accessory to which the receiver is connected.

3. Reselect the receiving antenna.
4. Increase the separation between the equipment and receiver.
5. Connect the equipment into an outlet or circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help and for additional suggestions.

FCC RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of body-worn accessories:

1. A palmOne brand body-worn accessory that has been tested for compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF energy.

2. An accessory that contains NO metal (snaps, clips, etc) and provides an area of at least 5 cm from the body-worn accessory to which the receiver is connected.

3. Reselect the receiving antenna.
4. Increase the separation between the equipment and receiver.
5. Connect the equipment into an outlet or circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help and for additional suggestions.

FCC RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of body-worn accessories:

1. A palmOne brand body-worn accessory that has been tested for compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF energy.

2. An accessory that contains NO metal (snaps, clips, etc) and provides an area of at least 5 cm from the body-worn accessory to which the receiver is connected.

3. Reselect the receiving antenna.
4. Increase the separation between the equipment and receiver.
5. Connect the equipment into an outlet or circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help and for additional suggestions.

FCC RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of body-worn accessories:

1. A palmOne brand body-worn accessory that has been tested for compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF energy.

2. An accessory that contains NO metal (snaps, clips, etc) and provides an area of at least 5 cm from the body-worn accessory to which the receiver is connected.

3. Reselect the receiving antenna.
4. Increase the separation between the equipment and receiver.
5. Connect the equipment into an outlet or circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help and for additional suggestions.

FCC RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of body-worn accessories:

1. A palmOne brand body-worn accessory that has been tested for compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF energy.

2. An accessory that contains NO metal (snaps, clips, etc) and provides an area of at least 5 cm from the body-worn accessory to which the receiver is connected.

3. Reselect the receiving antenna.
4. Increase the separation between the equipment and receiver.
5. Connect the equipment into an outlet or circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help and for additional suggestions.

FCC RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of body-worn accessories:

1. A palmOne brand body-worn accessory that has been tested for compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF energy.

2. An accessory that contains NO metal (snaps, clips, etc) and provides an area of at least 5 cm from the body-worn accessory to which the receiver is connected.

3. Reselect the receiving antenna.
4. Increase the separation between the equipment and receiver.
5. Connect the equipment into an outlet or circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help and for additional suggestions.

FCC RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of body-worn accessories:

1. A palmOne brand body-worn accessory that has been tested for compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF energy.

2. An accessory that contains NO metal (snaps, clips, etc) and provides an area of at least 5 cm from the body-worn accessory to which the receiver is connected.

3. Reselect the receiving antenna.
4. Increase the separation between the equipment and receiver.
5. Connect the equipment into an outlet or circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help and for additional suggestions.

FCC RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of body-worn accessories:

1. A palmOne brand body-worn accessory that has been tested for compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF energy.

2. An accessory that contains NO metal (snaps, clips, etc) and provides an area of at least 5 cm from the body-worn accessory to which the receiver is connected.

3. Reselect the receiving antenna.
4. Increase the separation between the equipment and receiver.
5. Connect the equipment into an outlet or circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help and for additional suggestions.

FCC RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of body-worn accessories:

1. A palmOne brand body-worn accessory that has been tested for compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF energy.

2. An accessory that contains NO metal (snaps, clips, etc) and provides an area of at least 5 cm from the body-worn accessory to which the receiver is connected.

3. Reselect the receiving antenna.
4. Increase the separation between the equipment and receiver.
5. Connect the equipment into an outlet or circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help and for additional suggestions.

FCC RF Safety Statement

In order to comply with FCC RF exposure safety guidelines, users MUST use one of the following types of body-worn accessories:

1. A palmOne brand body-worn accessory that has been tested for compliance at a qualified test laboratory and found to comply with the regulations regarding exposure to RF energy.

2. An accessory that contains NO metal (snaps, clips, etc) and provides an area of at least 5 cm from the body-worn accessory to which the receiver is connected.

3. Reselect the receiving antenna.
4. Increase the separation between the equipment and receiver.
5. Connect the equipment into an outlet or circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help and for additional suggestions.
<table>
<thead>
<tr>
<th>Specifications</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Radio</td>
<td>• GSM 850/900/1800/1900 quad band world phone</td>
</tr>
<tr>
<td></td>
<td>• GPRS class 10, class B, also supports CSD</td>
</tr>
<tr>
<td>Phone features</td>
<td>• Personal speakerphone</td>
</tr>
<tr>
<td></td>
<td>• Hands-free headset jack (2.5 mm, 3-barrel connector)</td>
</tr>
<tr>
<td></td>
<td>• Microphone mute option</td>
</tr>
<tr>
<td></td>
<td>• TTY compatible</td>
</tr>
<tr>
<td></td>
<td>• 6-way calling</td>
</tr>
<tr>
<td>Processor technology</td>
<td>• Texas Instruments OMAP 1510 (ARM) processor</td>
</tr>
<tr>
<td>Expansion</td>
<td>• SD/MMC slot (SD I/O compatible)</td>
</tr>
<tr>
<td>Battery</td>
<td>• Rechargeable Lithium Ion</td>
</tr>
<tr>
<td></td>
<td>• 3 hours full charge time</td>
</tr>
<tr>
<td></td>
<td>• 6 hours talk time, 10 days standby</td>
</tr>
<tr>
<td>Palm OS version</td>
<td>• Palm OS 5.2.x</td>
</tr>
<tr>
<td>Camera</td>
<td>• VGA resolution (640x480), 0.3 megapixel</td>
</tr>
<tr>
<td></td>
<td>• Automatic light balance</td>
</tr>
<tr>
<td>Size</td>
<td>• 4.41 in x 2.36 in x .87 in (11.2 cm x 6.0 cm x 2.2 cm) with antenna</td>
</tr>
<tr>
<td>Weight</td>
<td>• 5.92 ounces (167.6 grams)</td>
</tr>
<tr>
<td>IR</td>
<td>• Yes</td>
</tr>
<tr>
<td>Display</td>
<td>• LCD Touchscreen (includes stylus)</td>
</tr>
<tr>
<td></td>
<td>• 3375 colors (1.5-bit color, compatible with 16-bit applications)</td>
</tr>
<tr>
<td></td>
<td>• User-adjustable brightness and contrast</td>
</tr>
<tr>
<td>Keyboard</td>
<td>• Built-in QWERTY keyboard plus 6-way navigation control</td>
</tr>
<tr>
<td></td>
<td>• Backlight for low lighting conditions</td>
</tr>
<tr>
<td>Included software</td>
<td>• Phone (including Palm OS Contacts, Favorites, Dial Pad)</td>
</tr>
<tr>
<td></td>
<td>• Camera</td>
</tr>
<tr>
<td></td>
<td>• MMS</td>
</tr>
<tr>
<td></td>
<td>• Blazer Web Browser (Internet)</td>
</tr>
<tr>
<td></td>
<td>• Memo Pad</td>
</tr>
<tr>
<td></td>
<td>• PocketMirror Standard (for synchronizing with Microsoft Outlook for Windows)</td>
</tr>
<tr>
<td></td>
<td>• Calendar (Palm OS Date Book+)</td>
</tr>
<tr>
<td></td>
<td>• SMS</td>
</tr>
<tr>
<td></td>
<td>• Mail</td>
</tr>
<tr>
<td></td>
<td>• To Do List</td>
</tr>
<tr>
<td></td>
<td>• Calculator (basic and advanced)</td>
</tr>
<tr>
<td></td>
<td>• Palm Desktop and HotSync Manager</td>
</tr>
<tr>
<td></td>
<td>• CityTime world clock</td>
</tr>
<tr>
<td>System requirements</td>
<td>• Windows 98SE, Me, 2000 or XP with USB port</td>
</tr>
<tr>
<td></td>
<td>• Windows NT4 requires serial cable, sold separately</td>
</tr>
<tr>
<td></td>
<td>• Mac OS 10.1-10.3.x with USB port</td>
</tr>
<tr>
<td></td>
<td>• Later versions may also be supported</td>
</tr>
<tr>
<td>Operating and storage</td>
<td>• 0C-40C</td>
</tr>
<tr>
<td>temperature range</td>
<td>• 5% to 90% RH</td>
</tr>
</tbody>
</table>